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About this document

The products IBM® WebSphere®™ Business Integration Server Express and IBM®
WebSphere® Business Integration Server Express Plus are made up of the following
components: InterChange Server Express, the associated Toolset Express,
CollaborationFoundation, and a set of software integration adapters. The tools in
the Toolset Express help you to create, modify, and manage business processes.

you can choose from among the prepackaged adapters for your business processes
that span applications. The standard processes template--CollaborationFoundation--
allows you to quickly create customized processes.

This document describes the installation, configuration, business object
development, and troubleshooting for the WebSphere Business Integration Server
Express JText Adapter™.

Except where noted, all the information in this guide applies to both IBM
WebSphere Business Integration Server Express and IBM WebSphere Business
Integration Server Express Plus. The term "WebSphere Business Integration Server
Express” and its variants refer to both products.

What this document includes

This document describes installation, connector property configuration, business
object development, and troubleshooting for the WebSphere Business Integration
Server Express JText Adapter.

What this document does not include

This document does not describe deployment metrics and capacity planning issues
such as server load balancing, number of adapter processing threads, maximum
and minimum throughputs, and tolerance thresholds.

Such issues are unique to every customer deployment and must be measured
within or close to the exact environment where the adapter is to be deployed. You
should contact your IBM services representative to discuss the configuration of
your deployment site, and for details on planning and evaluating these kinds of
metrics, given your specific configuration.

Audience

This document is for WebSphere consultants and customers. You should be
familiar with the fundamentals of your integration broker, the fundamentals of
business object development, and possibly with data handler development.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
express installations, and includes reference material on specific components.
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You can download, install, and view WebSphere Business Integration Server
Express documentation at the following site:
http:/ /www.ibm.com /websphere /wbiserverexpress/infocenter.

Typographic conventions

vi

This document uses the following conventions:

courier font

bold
italic, italic
blue outline

{}
[]

/5 \

%text% and $text

ProductDir

Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

A blue outline, which is visible only when you view the
manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.1o0g.

In this document, backslashes (\) are used as the convention
for directory paths for Windows. Linux and i5/0S use
forward slashes (/) for directory paths. All WebSphere
business integration system product pathnames are relative
to the directory where the product is installed on your
system.

Text within percent (%) signs indicates the value of the
Windows text system variable or user variable. The
equivalent notation in a Linux environment is $text,
indicating the value of the text Linux environment variable.
Represents the directory where the product is installed. The
defaults for each platform are as follows:

* Windows: IBM\WebSphereServer
* i5/0S: /WQIBM/ProdData/WBIServer44/product
* Linux: /home/${username}/IBM/WebSphereServer

Adapter for JText User Guide



New in this release

Version 5.6.x

The release of this document for JText connector version 5.6.x contains the
following new features:

* The adapter, running on Windows, provides bidirectional script support for JText
meta-data

* Support for GB18030 Chinese code has been added for this release
e Support has been added for secure FTP

* A new Connector-specific boolean property, "NoPoll”, has been introduced, to
optionally turn off polling. The default value is false. When set to true, the
adapter only processes requests and does not poll.

The 5.6.x version of the adapter is supported on the following platforms:
* WIN 2003

e Linux:
RedHat 2.1 Enterprise Linux WS/AS/ES 3.0 Update 2, Intel (IA32
SuSE Linux ES 8.1 and Intel (IA32)
SuSE Linux ES 9.0, Intel (IA32)

» IBM i5/0S V5R3, OS/400 V5R2

Note: Unless explicitly stated, i5/0S refers to i5/0S and OS/400.
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Chapter 1. Overview of the JText adapter

This chapter describes the WebSphere Business Integration Server Express Adapter
for JText. The adapter enables an integration broker to communicate with an
application by exchanging text or binary files. This connector facilitates integration
of data with applications that lack an APL

Adapters consist of two parts: the connector framework and the
application-specific component. The connector framework, whose code is common
to all connectors, acts as an intermediary between the integration broker and the
application-specific component. The application-specific component contains code
tailored to a particular application. The connector framework provides the
following services between the integration broker and the application-specific
component:

¢ Receives and sends business objects

* Manages the exchange of startup and administrative messages

This document contains information about the connector framework and the
application-specific component. It refers to both of these components as the

adapter.

Topics included in this chapter are:

+ |“Adapter components”|

* [“Business objects used by the JText connector” on page 3|

* |"How the connector works” on page 6|

+ |“Connector features” on page 13|

* [“Processing locale-dependent data” on page 14|

For more information about the relationship of the integration broker to the
connector, see the System Administration Guide.

Use the JText adapter when:

¢ An application does not have a C, C++, or Java standard API through which an
integration broker can communicate.

* It is not feasible to have an event table for a custom-built application.

* String or binary files are the most appropriate method for exchanging data.

In these cases, the simplest method for integrating an application into a larger
system may be by exchanging string or binary files through the JText connector.

Adapter components

The JText adapter has the following components:

» [“Application-specific component” on page 2|

+ [“Data Handlers” on page 2|

* ["Meta-objects” on page 3|

© Copyright IBM Corp. 2004, 2005 1



illustrates the JText connector’s architecture with WebSphere InterChange
Server Express as the integration broker.

Integration broker

JText|connector

v

Global Event Business
oba ven object Application
functions notification handlers ﬁz PP
A .
File File writer

Y \J
Data handler instance

Figure 1. JText connector architecture

Application-specific component

The JText adapter’s application-specific component manipulates files and calls a
specified data handler to convert data between business objects and strings or byte
arrays. It also handles communication with the integration broker.

Data Handlers

The goal of the JText connector is to provide conversion between any existing file
format and a business object. To do so, it uses the data handler specified in the
connector’s meta-object configuration.

The data handler performs the conversion without interacting with the file system
in any way, either by reading from or writing to files. All interaction with the text
file is handled by other connector components.

To handle data conversion, you can use data handlers that WebSphere Business
Integration Server Express Adapter Framework provides or data handlers that you
create to handle specific text-formatting needs. The product provides the following
data handlers:

* NameValue — Parses text data based on named fields. In this case, the text file
contains fields that identify the business object type (BusinessObject=BOname),
verb (Verb=verbName), and number of attributes (AttributeCount=numericValue).

* Delimited — Used primarily where the efficiency of machine reading is most

important. Parses text data based on a specified delimiter that separates the
individual fields of a business object’s data.

* FixedWidth — Parses text data by using fixed-length fields. The field lengths are
specified by the MaxLength property of each business object attribute. The value
of this property is stored in the business object definition.

2 Adapter for JText User Guide



For more information, see ['How data handler processing works” on page 12 For
more information about each of the product-delivered data handlers, see the Data
Handler Guide.

Meta-objects

In addition to the standard and application-specific connector configuration
properties that you set in Connector Configurator Express, the JText connector has
a set of configuration properties that enable you to configure the connector to
process different business objects differently. You set these properties by using JText
meta-objects. A meta-object is a special kind of business object that contains
configuration information.

The connector uses the meta-object information to determine what classes to use to
transform strings or byte arrays that it reads from files into business objects, and to
format strings or byte arrays from business objects into files. The JText meta-objects
specify the directories, file extensions, filenames, business object delimiters, and
data handlers to use during event, and request processing.

The JText adapter uses meta-objects internally. It does not send them through the
integration broker. For more information about using meta-objects to configure the
connector, see [Chapter 4, “Using JText connector meta-objects,” on page 43

Business objects used by the JText connector

Business objects for the JText connector must deliver data in the format required by
the data handler specified for conversion. However, the JText connector may not
need a set of specially designed business objects comparable to application-specific
business objects for an application connector.

For example, the NameValue data handler requires each piece of data to have a
string that identifies it (such as CustomerName=Kumar, Region=NE, and
Department=HR). Because every generic business object definition contains attributes
whose names identify each piece of data, the JText connector can use generic
business objects.

However, because generic business objects represent a superset of information
required by a multitude of different applications, each generic business object
usually contains far more information than is required by any one application.

Therefore, to convert data into a manageable size for each application, a good
practice is to create your own business object for each type of data to be processed.
In the business object, provide only the data required by the application and the
information required by the data handler.

For example, for the FixedWidth data handler, you must ensure that every business
object attribute has a value specified for the MaxLength attribute property. For the
WebSphere Business Integration Server Express Data Handler for XML, other
specific information is required. On the other hand, for the NameValue and
Delimited data handlers, the business object needs not contain any information
that is not already contained in a generic business object. See the Data Handler
Guide for information specific to each data handler.

In addition to delivering data, a business object can contain information that

enables the connector to dynamically obtain the business object’s event filename or
to return the output filename to the integration broker. To configure the connector

Chapter 1. Overview of the JText adapter 3



for this dynamic processing, the application-specific information at the
business-object level must contain the following name-value pair:

* cw_mo_JTextConfig = DynChildMOAttrName

If the business object contains additional application-specific information that is
used by the data handler, the name-value pair must appear first in the business
object, and must be separated from the additional application-specific information
by a semicolon (;). The connector reads the name-value pair up to the semicolon to
determine whether to use dynamic processing, then passes any information that
appears after the semicolon to the data handler.

Using a dynamic child meta-object

A dynamic child meta-object enables the filename to be exchanged with
InterChange Server Express. This section describes:

“Why use a dynamic child meta-object?”]

« [“How to use a dynamic child meta-object” on page 4|

+ [“Attributes of a dynamic child meta-object” on page 5|

Why use a dynamic child meta-object?
Create and use a dynamic child meta-object to cause the connector to do the
following:

Service Call Requests

* Dynamically generate an output filename for each type of business object (based
on the value inserted into the child’s OutFileName attribute by the integration
broker) or for each individual business object (if the integration broker specifies
sequencing).

Note: The connector uses the child’s FilelWriteMode attribute to determine
whether to overwrite or append to the file specified in the child’s
OutFileName attribute.

¢ Return the name of each connector-generated output filename (if the child’s
OutFileName attribute does not contain a value). In this case, the connector does
the following:

— derives the name from the parent business object’s name
— writes the object to that file
— populates the OutFileName meta-object attribute with the derived name

— passes the derived name back to the integration broker, which obtains the
dynamically created output filename without having specified it

Event Processing

The connector populates the child’s InFileName attribute with the name of the file
from which the business object was read.

How to use a dynamic child meta-object
To cause the connector to process the filename dynamically, you must:

1. Create a dynamic child meta-object with specific attributes.

2. In the data business object, add an attribute that represents the dynamic child
meta-object.

3. In the data business object, specify the following in the application-specific
information at the business-object level:

4 Adapter for JText User Guide



cw_mo_JTextConfig = DynChildMOAttrName

where DynChildMOAttrName is the name of the attribute in the data business
object that represents the dynamic child business object. For an example, see

oure 2|

Important: The cw_mo_ prefix is required when you use a data handler. If the
prefix is missing, the connector writes the dynamic child
meta-object to the specified output file as if it were a data business
object.

4. In the dynamic child meta-object, specify values for the attributes in the
dynamic child meta-object.

Attributes of a dynamic child meta-object
A dynamic child meta-object must contain the following attributes:

» FileWriteMode — A string attribute whose value specifies whether the connector
appends to or overwrites an existing output file. The value of this attribute can
be either "a” for append or "0” for overwrite. The connector examines only the
first letter and does not consider the value’s case.

* InFileName — A string attribute that is populated with the event file name (file
and absolute path from which the business object is obtained).

* OutFileName — A string attribute whose value can contain the filename, the
absolute path and filename, or an FTP URL for the connector to use when
writing to the output file.

— If this attribute contains only the filename, the connector writes the specified
file to the directory from which it was started.

— If this attribute contains the absolute path and filename, the connector writes
the specified file to the specified directory.

— If this attribute contains only an FTP URL, the connector obtains the login,
password, and port values from the EventDir attribute of the top-level JText
meta-object.

— If this attribute contains an FTP URL that includes the login, password, and
port values, the connector uses the values specified in this attribute and
overrides those specified in the EventDir attribute of the top-level JText
meta-object.

For more information, see [’Specifying a remote FTP file system” on page 66,

illustrates an example Customer business object that contains a dynamic
child meta-object.

Chapter 1. Overview of the JText adapter 5



Customer business object

MO_DynamicChild business object

Customer
Version =1.0 MO_DynamicChild
AppSpecificlnfo: cw_mo_JTextconfig=ChildMO TVersion =1.0

oA

Attribute1 FileWriteMode: a

InFileName: C:\TEMP\MyCustomer.in
OutFileName:

ChildMO: MO_DynamicChild
Type: MO_DynamicChild
Relationship: Containment
Cardinality: 1

Figure 2. Example of a dynamic child meta-object

How the connector works

The JText connector communicates with an application through the exchange of
text or binary files. It performs the following primary tasks when processing
business objects:

¢ Event notification

* Request processing

This section describes these tasks. It also explains how data handler processing
works and how the JText connector processes verbs.

Event notification

The JText connector handles events differently from other connectors. Unlike
connectors that depend on third-party applications, the JText connector does not
have an event table. Instead, it treats the event directory as an event table.

The following operations occur when the JText connector handles events:

1. The connector polls for events by checking specified directories for files with
specified extensions. The presence of a file with the specified extension in the
specified directory is considered the equivalent of an event. The connector
reads event files directly from the event directory without interpretation. It uses
a parsing method to determine which subsection represents each business
ect. For more information, see [“Polling for specific business objects” on page|
63

2. The connector creates an instance of the data handler (based on values
specified in the JText meta-object for the data business object).

3. The connector calls getBO()or getBOByteArray() on the data handler instance,
and sends the string or byte array that represents the business object to it. The
connector passes each element that represents a business object to the data

6 Adapter for JText User Guide



handler. When a file represents multiple business objects, the connector sends
only an element (that is, a string or byte array representation of a single
business object), not the entire file.

4. The data handler converts the string or byte array to a business object and
returns it to the connector. The data handler also reports errors and provides
tracing.

5. The data handler performs default verb processing. The person who develops
the data handler must specify logic for setting the verbs, because the connector
does not provide this logic. For information on how the sample data handlers
set verbs, see the Data Handler Guide.

6. If the data handler encounters any error that prevents it from creating a
business object, the connector archives the string or byte array with the.fail
extension. If the data handler succeeds, the connector checks for subscriptions
to the business object.

* If the connector does not subscribe to the business object, it writes it to an
archive file with the .unsub extension.

e If the connector subscribes to the business object, it sends the business object
to the integration broker.

7. If the connector successfully sends the business object to the integration broker,
it archives the file with the .success or .partial extension, depending on
whether any business object in the event file has failed processing. If the
connector fails to send the business object, it archives the file with the .fail
extension.

The JText connector processes event files in alphabetic order according to their file
names. Depending on its configuration, the JText connector can pick up all files in
the event directory or pick up only those with a specified extension. For more
information, see [“Specifying multiple event files or multiple event directories” on|
he SortFilesOnTimestamp property allows the JText connector to process
event files in the order of their time stamps, from the oldest to the most recent,
regardless of their location. In other words, the JText connector processes files
located in separate directories in the chronological order of their time stamps.For
more information, see |“SortFilesOnTimestamp” on page 31/

The Pol1Quantity property specifies the maximum number of business objects that
the connector can post to the integration broker in a given poll. For example,
assume that the value of Pol1Quantity is set to 5 and that there are two files in a
directory in which the connector is polling. The first file has four business objects
and the second has 12 business objects. On the first poll call, the connector
performs the following steps:

1. Sends all four business objects from the first file, archiving each business object
as it processes it.

2. Sends the first business object from the second file.

On the second poll call, the connector sends the 2nd through 6th business objects
from the second file. On the third poll call, the connector sends the 7th through
11th business objects from the second file. On the fourth poll, the connector sends
the last business object. The connector archives each business object after
processing it. If any of the business objects in a file fail processing, the connector
archives the entire file with the .orig extension.

For more information, see:

* On using the Pol1Quantity property to tune performance, see
[performance of the JText connector” on page 75.|

Chapter 1. Overview of the JText adapter 7



 On specifying the event directory and extension, see [‘Specifying event]
[directories and extensions” on page 56.|

* On specifying event processing, see [“Specifying event notification” on page 56,

shows an event notification operation (numbers in the graphic do not
correlate to the steps outlined above).

Integration broker

A

©

JText connector

Global Event Business
functions notification object

handlers

N
[OL) 0
©) ©) File | File writer

A J

Data handler instance

@ GetBO(String) or
GetBO(byte[ ])

Application

Figure 3. Event notification operation

Event archiving

After it has processed an event, and if it is configured to enable archiving, the JText
connector writes the business object string or byte array representation of one
business object into a file in the local archive directory. It names the file with an
underscore (), a time stamp, and a file extension that corresponds to the event
status. The delivered default extensions are success, partial, unsub, orig, and
fail. The underscore and time stamp are appended after the filename and before
the file extension.

The time stamp is an underscore-separated list that contains the year, month, day;,
hour, minute, second, and millisecond of the system time. It ensures that archived
filenames are unique and that the connector does not overwrite an existing file
with the same name. The format of the archived file is:

BOName _YYYY_MM_DD_HH_MM_SS_sss. [extension]

For example, the connector might rename a successfully processed file named
Customer.in to Customer_2003_11_15_18 24 59 999.success.

The JText connector archives a business object to the .fail file if a formatting error
occurs, or if the connector fails to send the business object to the integration
broker. The JText connector archives a business object to a file with an extension of
.unsub if the connector does not subscribe to it. After you examine these archive
files and correct any formatting errors or start the processes that subscribe to the
business objects, resubmit the business objects in these files for processing.

For more information on archiving, see [“Specifying event archiving” on page 57)
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Default file extensions for event and archive files

Because the JText connector does not use event and archive tables, it updates event
status by changing file extensions. shows the default file extension values
that the JText adapter delivers for event and archive files.

Table 1. Default file extensions

Default
File type Event status/description file Delivered default directory
extension
Event new in Linux:
/tmp/JTextConn/Default/Event
Windows:
C:\temp\JTextConn\Default\Event
i5/0S:
No default provided
Archive  success (if all the success Linux:
business /tmp/JTextConn/Default/Archive
objects in the event file Windows:
process successfully, this C:\temp\JTextConn\Default\Archive
file contains all the i5/0S:
business objects) No default provided.
Archive  success (if some of the partial Linux:
business objects in the /tmp/JTextConn/Default/Archive
event file fail processing, Windows:
this file contains only C:\temp\JTextConn\Default\Archive
the successfully i5/0S:
processed ones) No default provided.
Archive  unsubscribed unsub Linux:
/tmp/JTextConn/Default/Archive
Windows:
C:\temp\JTextConn\Default\Archive
i5/0S:
No default provided.
Archive  entire original event file orig Linux:
(created only if any /tmp/JTextConn/Default/Archive
business object fails Windows:
processing or is C:\temp\JTextConn\Default\Archive
unsubscribed, even if the i5/0S:
event file contains only No default provided.
one business object)
Archive  fail fail Linux:
/tmp/JTextConn/Default/Archive
Windows:
C:\temp\JTextConn\Default\Archive
i5/0S:
No default provided.
Output  out out Linux: /tmp/JTextConn/Default/Out
Windows:
C:\temp\JTextConn\Default\Out
i5/0S:

No default provided.

Important: The access sequence among multiple applications that access and
process the same file at the same time is important. Analyze all
operations performed on a given file to avoid issues with file locking
and incomplete data.

Chapter 1. Overview of the JText adapter 9



Note: The connector treats every file in the event directory with the specified
extension as an input file. Ensure that the input file extension differs from
the archive file extension, or that the input files and archive files are stored
in different directories, to prevent the connector from treating an archived
file as an event.

For information on specifying your own file extensions, event directory, and output
directory, see [Table 8 on page 46}.

Request processing

When processing a service call request, the connector converts the business object
to an output string or byte array, then writes it to a file.

Before converting the business object, however, the connector determines whether
the business object has been configured for dynamic file naming; that is, whether
the business object contains a dynamic child meta-object. In this case, the connector
dynamically names the output file or returns the name of the output file that it
generates.

This section describes service call request processing when:

+ |“Data business object does not specify dynamic file naming”/|

+ |“Data business object contains a dynamic child meta-object” on page 10|

Data business object does not specify dynamic file naming

When the data business object does not specify dynamic file naming, the connector

performs the following operations to handle service call requests:

1. The connector receives a business object request.

2. The connector determines that the AppSpecificInfo property at the
business-object level must contain the following:
cw_mo_JTextConfig = DynChildMOAttrName

3. The connector checks the configuration of the top-level JText meta-object to
determine which data handler to call. By default, this meta-object specifies the
MO_DataHandler_DefaultNameValueConfig data-handler meta-object, which
represents the NameValue data handler.

4. The connector creates an instance of the appropriate data handler and sends the
business object to it.

5. The data handler converts the business object to a string or a byte array, which
it returns to the configuration. The data handler also reports errors and
provides tracing.

6. The connector writes the string or byte array to a file.

For information on configuring the connector to process requests, see
request processing” on page 58}

Data business object contains a dynamic child meta-object
When the data business object contains a dynamic child meta-object, the connector
performs the following operations to handle service call requests:

1. The connector receives a business object request.

2. The connector determines that the AppSpecificInfo property at the
business-object level contains the following text:

cw_mo_JTextConfig = DynChildMOAttrName

10 Adapter for JText User Guide



Note: If the business object’s application-specific information does not specify a
dynamic child meta-object and does not contain such a child, the
connector processes the business object as described in ['Data business|
[object does not specify dynamic file naming” on page 10|

3. The connector gets the name of the output file from the dynamic child
meta-object’s OutFileName attribute.

* If this attribute contains a value, the connector checks whether a file by that
name already exists. If the file does not exist, the connector creates a new
output file, using the value of the attribute to name the file. If the file already
exists, the connector appends to or overwrites the existing file (based on the
value of the child meta-object’s FileliriteMode).

Important: If the value of the FileWriteMode attribute begins with any value
other than an "0”, the connector defaults to append mode.

 If this attribute does not contain a value (that is, OutFileName=CxIgnore), the
connector derives the filename from the name of the parent business object
that contains this child meta-object, and uses the configuration of the
top-level JText meta-object to determine the output file’s location. After
writing the business object to the file, the connector returns the file’s name
and path in this attribute.

4. The connector checks the configuration of the top-level JText meta-object to
determine which data handler to call. By default, this meta-object specifies the
MO_DataHandler_DefaultNameValueConfig data-handler meta-object, which
represents the NameValue data handler.

5. The connector creates an instance of the appropriate data handler and sends the
business object to it.

6. The data handler converts the business object to a string or a byte array, which
it returns to the configuration. The data handler also reports errors and
provides tracing.

7. The connector writes the string or byte array to a file whose name it derives in
step El above.

ﬂlustrates the JText connector components when the connector processes

requests from the integration broker, InterChange Server Express, to the destination
application.
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Figure 4. Business object request operation

How data handler processing works

The connector uses a data handler instance to convert between business objects
and strings or byte arrays that are read from event files. The data handler instance
also reports errors and provides tracing.

The connector creates an instance of a data handler based on the value of the
EventDataHandler and OutputDataHandler attributes in the top-level JText
meta-object. These attributes identify the data-handler meta-object that the
connector uses to create the instance of the data handler. The data-handler
meta-object can represent a delivered or custom data handler. For more
information, see the Data Handler Guide.

The connector determines which interface, string or byte array, based on the setting
of the DataProcessingMode meta-object. For additional information on this
meta-object, see [Table 8 on page 46]

After receiving the configuration information, the connector performs the following
steps:
1. Instantiates a data handler.

2. Calls the data handler’s setOption() method to set the data handler’s
TracingSubSystem attribute to the connector’s name. The data handler uses this
value to include the connector’s name in the trace messages it writes.

After the data handler has been created and configured, the connector calls the
appropriate methods in the data handler to perform the conversion of data to or
from a business object.

» For event notification, the connector calls the getBO(String) or getBO(byte[])
method on the data handler. The connector passes to the data handler the string
from a file that is be converted to a business object. The data handler returns a
business object.
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» For request processing, the connector calls the getStringFromB0() or
getByteArrayFromB0() method on the data handler. The connector passes to the
data handler the business object to be converted to a string or byte array. The
data handler returns a serialized version of the business object, in the form of a
string or byte array.

The getBO(String) or getBO(byte[])and the getStringFromBO() or getByte
ArrayFromB0() methods always send or receive the entire business object hierarchy
of a top-level parent and all of its child business objects, respectively.

In either case, the data handler is responsible for filtering out any meta-object data
so that it passes only business object-specific data. The product-delivered data
handlers provide this functionality. If you use custom data handlers, they must
also provide this functionality.

Business object verb processing for requests

When handling requests, the JText connector does not handle one verb differently
from another. It writes to files without performing update, retrieve, or delete
operations, regardless of the verb associated with the business object.

When processing requests, the JText connector sets all attributes with a value of
CxIgnore to their default values if the following conditions are true:

* The verb is Create.
* The connector’s UseDefaults property is set to true.
* The attribute is set to Required.

* Default values have been set for the attributes in the business object
specification.

Connector features

Along with event notification and business object request processing, the JText
connector provides the following capabilities:
* Varied configurations for different business objects; for example, you can

configure different business objects to use different directories and file
extensions, or different data formats.

* Configuration capabilities for file extensions, directory location for archive file
storage, format type, and file sequencing.

* Configuration capabilities for dynamically determining the output filename for
each business object, or for returning the full name of a generated output file.

* Failure recovery.

¢ Custom data handler capabilities, which means that you can create your own
data handler without recompiling the connector code. You need only change the
configuration properties to use the new class you have created.

* The ability to exchange data with remote FTP locations as well as local file
system directories.

For more information, see [Chapter 2, “Installing the JText adapter,” on page 15,|
(Chapter 4, “Using JText connector meta-objects,” on page 43 [and the Data Handler
Guide.
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JText differences from other adapters

While the JText connector enables the transfer of data from a source application to
a destination application like other adapters, it is unique in the following ways:

* It processes all business objects in the same way. In other words, because it
always writes the business object to a file, it performs only Create operations
(regardless of the incoming verb).

¢ It does not interpret the contents of the business objects that it handles. In other
words, it reads each business object as a potential string or byte array in which
key values have no more significance than other data.

* It uses meta-object values for much of its configuration. For more information,
see [Chapter 4, “Using JText connector meta-objects,” on page 43.|

* It does not have an event table. Instead, it treats the configured event directory
as an event table.

Processing locale-dependent data

The connector has been internationalized so that it can support double-byte
character sets, and deliver message text in the specified language. When the
connector transfers data from a location that uses one character code set to a
location that uses a different code set, it performs character conversion to preserve
the meaning of the data. The Java runtime environment within the Java Virtual
Machine (JVM) represents data in the Unicode character code set. Unicode contains
encodings for characters in most known character code sets (both single-byte and
multibyte). Most components in the WebSphere Business Integration Server
Express system are written in Java. Therefore, when data is transferred between
most WebSphere Business Integration Server Express system components, there is
no need for character conversion. To log error and informational messages in the
appropriate language and for the appropriate country or territory, configure the
Locale standard configuration property for your environment. For more
information on these properties, see |“Standard configuration properties for|
fconnectors,” on page 89|
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Chapter 2. Installing the JText adapter

This chapter describes how to install and configure the JText connector.
+ [“Overview of the installation tasks”|

* |“Adapter environment’

* [“Installing the JText adapter” on page 16|

» |“Verifying installation” on page 1§

Overview of the installation tasks

To install the adapter for JText, you must perform the following tasks:

* Install the integration broker This task, which includes installing the WebSphere
business integration system and i5/0S the integration broker, is described in the
installation documentation for your broker and operating system.

* Install the adapter and related files This task includes installing the files for the

adapter from the software package onto your system. See [“Installing the JText
[adapter” on page 16/

Before installing the adapter, you must understand the adapter environment. For
further information, see [‘Adapter environment.”|

In this chapter

The tasks described in this chapter are as follows:

Table 2. Installing the adapter: task roadmap

Associated procedure(s)

Task (see...) For more information (see...)
Installing the adapter “Installing the JText adapter”| | WebSphere Business
on page 16.| Integration Server Express

Installation Guide for
Windows, for Linux, or for
i5/0S

Verifying installation “Verifying installation” on|

page 16.|

Adapter environment

Before installing, configuring, and using the adapter, you must understand its
environmental requirements:

+ |[“Overview of the installation tasks”|

* [“Adapter platforms”]

+ |“Adapter prerequisites” on page 16|

* |“Locale-dependent data” on page 16|

Adapter platforms
The adapter is supported on the following platforms:

 All operating system environments require the Java compiler (IBM JDK 1.4.2 for
Windows 2003) for compiling adapters.
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* IBM i5/0S V5R2 and OS/400 V5R3
* Windows 2003 (Standard Edition and Enterprise Edition)

* Windows XP with SErvice Pack 1A, for WebSphere Business Integration Adapter
Framework (administrative tools only)

* Linux:
RedHat 2.1 Enterprise Linux WS/AS/ES 3.0 Update 2, Intel (IA32)
SuSE Linux ES 8.1, Intel (IA32)
SuSE Linux ES 9.0, Intel (IA32)

Adapter prerequisites

Before running the JText connector, create read/write permissions on the event,
output, and archive directories that will contain the text files that the connector
reads from and writes to. This needs to be done on both the local and remote
servers.

Locale-dependent data

The connector has been internationalized so that it can support double-byte
character sets, and deliver message text in the specified language. When the
connector transfers data from a location that uses one character code to a location
that uses a different code set, it performs character conversion to preserves the
meaning of the data.

The Java runtime environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encoding for characters in
most known character code sets (both single-byte and multibyte). Most
components in the WebSphere business integration system are written in Java.
Therefore, when data is transferred between most integration components, there is
no need for character conversion. To log error and informational messages in the
appropriate language and for the appropriate country or territory, configure the
Locale standard configuration property for your environment. For more
information on configuration properties, see|’Standard configuration properties for]
fconnectors,” on page 89

This adapter supports the processing of bidirectional script data for languages such
as Arabic, Hebrew, Urdu, Farsi and Yiddish. To use the bidirectional capacity, you
must configure the bidirectional standard properties. For more information, refer to
the standard configuration properties for connectors ir{“Standard configuration|
[properties for connectors,” on page 89|

Installing the JText adapter

For information on installing WebSphere Business Integration Server Express
adapter products, refer to the WebSphere Business Integration Server Express
installation guide for Windows, for Linux, or for i5/0S. The guide is located in the
WebSphere Business Integration Server Express Adapters Infocenter at the
following site: http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter.

Verifying installation

The sections below describe the paths and filenames of the product after
installation and how to verify your adapter installation.
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Verifying installation on a Windows system

Before you begin, install the adapter. The Installer copies the standard files
associated with the adapter into your system. The utility installs the connector into
the ProductDir\connectors\JText directory, and adds a shortcut for the connector
to the Start menu.

To verify the adapter installation on a Windows system, change to the directory
where you installed the adapter ProductDir\ and compare the contents to those
listed in Table 3.

Table 3 describes the Windows file structure used by the adapter, and shows the
files that are automatically installed when you choose to install the adapter
through Installer.

Table 3. Windows file structure for the connector

Subdirectory of ProductDir Description

\connectors\JText\CWJText.jar Contains classes used by the JText connector
only

\connectors\JText\start_JText.bat The startup script for the generic connector

\connectors\messages\JTextConnector.txt |Message file for the connector

\repository\JText\CN_JText.txt Repository definition for the connector. The
default name is CN_]JText.txt.

\connectors\JText\start_]JText_service.bat The startup script for the connector service.

\connectors\JText\dependencies\ Third party.jar packaged with the connector

commons-net-1.1.0.jar, dependencies\
jakarta-oro-2.0.8.jar

Note: All product pathnames are relative to the directory where the product is
installed on your system.

Verifying installation on a Linux system

Before you begin, install the adapter. The Installer copies the standard files
associated with the adapter into your system. The utility installs the connector
agent into the ProductDir/connectors/JText directory.

To verify the adapter installation on a Linux system, change to the directory where
you installed the adapter ProductDir/ and compare the contents to those listed in
Table 9.

Table 4 describes the Linux file structure used by the adapter, and shows the files
that are automatically installed when you choose to install the adapter through
Installer.

Table 4. Linux file structure for the connector

Subdirectory of ProductDir Description

/connectors/JText/CWJText. jar Contains classes used by the JText connector
only

/connectors/JText/start_JText.sh The startup script for the generic connector

/connectors/messages/JTextConnector.txt |Message file for the connector

/repository/JdText/CN_JText.txt Repository definition for the connector. The
default name is CN_JText.txt.
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Table 4. Linux file structure for the connector (continued)

Subdirectory of ProductDir Description

/connectors/JText/dependencies/ Third party.jar packaged with the connector
commons-net-1.1.0.jar, dependencies/
jakarta-oro-2.0.8.jar

Note: All product pathnames are relative to the directory where the product is
installed on your system.

Verifying installation on i5/0S systems

By default, the adapter is installed int he /QIBM/ProdData/WBIServer44/product
directory (referred to as ProductDir). Table 4 describes the i5/0S file structure used
by the connector, and shows the files that are automatically installed during a
typical installation. To verify the adapter installation on an i5/OS system, change
to the directory were you installed the adapter and compare the contents to those
listed in Table 5.

Table 5. i5/0S file structure for the connector

Directory Description

ProductDir/connectors/JText Contains the connector CW]Text.jar file and
the start_JText.sh startup file.

ProductDir/repository/JText Contains the BIA_CN_]Text.txt repository
definition.

ProductDir/connectors/JText/Dependencies |Contains the license agreement, REAME
files, and the third-party
commons-net-1.10.jar and jakarta-oro-2.0.0.jar
files.

ProductDir/connectors/messages Contains the JTextConnector.txt file and the
JTextConnector_II_TT.Ttxt files (message files
specific to a language (II) and a country or
territory (TT)).

ProductDir/1ib Contains the WBIA jar file.

ProductDir/bin Contains theCWConnEnv.sh file.

Note: You can quickly start the connector with the Console function. For more
information, refer to the online help provided with the Console.
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Chapter 3. Configuring the JText adapter

This chapter describes how to install and configure the JText connector.

“QOverview of Connector Configurator Express’|

“Starting Connector Configurator Express” on page 20|

“Running Configurator from System Manager” on page 21|

“Creating a connector-specific property template” on page 21|

“Creating a new configuration file” on page 24|

2

[‘Using an existing file” on page 25
"’Completing a configuration file” on page 2€|

[“Setting the configuration file properties” on page 27
“Saving your configuration file” on page 36|

[“Changing a configuration file” on page 36|

[“Completing the configuration” on page 36|

“Using Connector Configurator Express in a globalized environment” on page|
3

[“Starting the connector” on page 37

[“Starting the connector” on page 37

[“Stopping the connector” on page 3§|

[“Creating multiple connector instances” on page 39

[“Adding supported business objects” on page 41|

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with InterChange Server Express.

You use Connector Configurator Express to:

Create a connector-specific property template for configuring your connector.

Create a connector configuration file; you must create one configuration file for
each connector you install.

Set properties in a configuration file.

You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with InterChange Server Express, maps for use with
collaborations as well as specify logging, messaging, and tracing, and data
handler parameters, as required.

The mode in which you run Connector Configurator Express, and the
configuration file type you use, may differ according to the integration broker you
are running.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).
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Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The Standard Properties window in Connector Configurator Express will show the
properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 21[to set up a new one.

Running connectors on Linux

Connector Configurator Express runs only in a Windows environment. If you are
running the connector in a Linux environment, use Connector Configurator
Express in Windows to modify the configuration file and then copy the file to your
Linux environment.

Some properties in the Connector Configurator Express use directory paths, which
default to the Windows convention for directory paths. If you use the
configuration file in a Linux environment, revise the directory paths to match the
Linux convention for these paths. Select the target operating system in the toolbar
drop-list so that the correct operating system rules are used for extended
validation.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator Express without running System Manager
and work with connector configuration files.

To do so:

* Start>All Programs, click IBM WebSphere Business Integration
Express>Toolset Express>Development>Connector Configurator Express.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration
Broker, you can select InterChange Server Express.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see[“Completing a configuration file” on page 26)
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Running Configurator from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:
1. Open the System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator. The
Connector Configurator Express window opens and displays a New Connector
dialog box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select InterChange Server Express.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator Express opens
and displays the configuration file with the integration broker type and file
name at the top.

¢ From Connector Configurator Express, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

* Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

+ To create a new template, see [“Creating a new template” on page 21}

¢ To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your \ProductDir\bin\Data\App
directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator Express:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

¢ Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.
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* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.

 If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

¢ This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Property Subtype
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

The Property Subtype can be selected when Property Type is a String. It is an
optional value which provides syntax checking when you save the configuration
file. The default is a blank space, and means that the property has not been
subtyped.

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Right-click on the square to the left of the Value column heading.

2. From the pop-up menu, select Add to display the Property Value dialog box.
Depending on the property type, the dialog box allows you to enter either a
value, or both a value and a range.

3. Enter the new property value and click OK. The value appears in the Value
panel on the right.
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The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.

Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Pol1Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.

2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following;:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the \bin directory where you
have installed Connector Configurator Express.

Setting pathnames
Some general rules for setting pathnames are:

* The maximum length of a filename in Windows, Linux, and i5/0S is 255
characters.
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* In Windows, the absolute pathname must follow the format
[Drive:][Directory]\filename: for example,
C:\WebSphereAdapters\bin\Data\Std \StdConnProps.xml
In Linux the first character should be /.

* Queue names may not have leading or embedded spaces.

Creating a new configuration file

When you create a new configuration file, you must name it and select
InterChange Server Express as the integration broker.

You also select an operating system for extended validation on the file. The toolbar
has a droplist called Target System that allows you to select the target operating
system for extended validation of the properties. The available options are:
Windows, Linux, i5/0S, or Other (if not Windows or Linux or i5/0S); and
None-no extended validation (switches off extended validation). The default on
startup is Windows.

To start Connector Configurator Express:

* In the System Manager window, select Connector Configurator Express from
the Tools menu. Connector Configurator Express opens.

¢ In stand-alone mode, launch Connector Configurator Express.

To set the operating system for extended validation of the configuration file:
* Pull down the Target System: droplist on the menu bar.

* Select the operating system you are running on.

Then select File>New>Connector Configuration. In the New Connector window,
enter the name of the new connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker in the
Integration Broker field, select InterChange Server Express. Complete the
remaining fields in the New Connector window, as described later in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Set the operating system for extended validation of the configuration file using
the Target System: droplist on the menu bar (see “Creating a new configuration
file” above).

2. Click File>New>Connector Configuration.
3. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator Express does not check the spelling of

the name that you enter. You must ensure that the name is
correct.
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* System Connectivity
Click InterChange Server Express.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

4. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

5. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running. If you save as a file, the Save File
Connector dialog box appears. Choose *.cfg as the file type, verify in the File
Name field that the name is spelled correctly and has the correct case, navigate
to the directory where you want to locate the file, and click Save. The status
display in the message panel of Connector Configurator Express indicates that
the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

6. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator Express window, as described later in this
chapter.

Using an existing file
You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_JTEXT.txt for the JTEXT connector).

* An ICS repository file.
Definitions used in a previous InterChange Server Express implementation of
the connector may be available to you in a repository file that was used in the
configuration of that connector. Such a file typically has the extension .1in or
.out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete

until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.
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2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

 Configuration (*.cfg)

* ICS Repository (*.1in, =.out)
Choose this option if a repository file was used to configure the connector in
an InterChange Server Express environment. A repository file may include

multiple connector definitions, all of which will appear when you open the
file.

o All files (*.*)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1. Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS.

2. The Standard Properties tab will display the connector properties associated
with the selected broker. The table shows Property name, Value, Type, Subtype
(if the Type is a string), Description, and Update Method.

3. You can save the file now or complete the remaining configuration fields, as
described in [‘Specifying supported business object definitions” on page 32.

4. When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.

Before you created the configuration file, you used the Target System droplist
that allows you to select the target operating system for extended validation of
the properties.

Before it saves the file, Connector Configurator Express checks that values have
been set for all required standard properties. If a required standard property is
missing a value, Connector Configurator Express displays a message that the
validation failed. You must supply a value for the property in order to save the
configuration file.
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If you have elected to use the extended validation feature by selecting a value
of Windows, Linux, i5/0S, or Other from the Target System droplist, the
system will validate the property subtype s well as the type, and it displays a
warning message if the validation fails.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator Express requires values for properties in these categories
for connectors:

 Standard Properties

* Connector-specific Properties
¢ Supported Business Objects
* Trace/Log File values

* Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on InterChange Server Express, values for these properties
are also required:

* Associated Maps

* Security

Important: Connector Configurator Express accepts property values in either
English or non-English character sets. However, the names of both
standard and connector-specific properties, and the names of supported
business objects, must use the English character set only.

Standard properties differ from connector-specific properties as follows:

 Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in the Standard
Properties appendix. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are

color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.
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* Value fields are configurable.

* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.

2. Either enter a value, or select one from the drop-down menu if it appears.

Note: If the property has a Type of String, it may have a subtype value in the
Subtype column. This subtype is used for extended validation of the
property.

3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

» To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

To get more information on a particular standard property, left-click the entry in
the Description column for that property in the Standard Properties tabbed sheet.
If you have Extended Help installed, an arrow button will appear on the right.
When you click on the button, a Help window will open and display details of the
standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.

If installed, the Extended Help files are located in
<ProductDir>\bin\Data\Std \Help\ <RegionalSetting>\.

Setting connector-specific configuration properties

For connector-specific configuration properties, you can add or change property
names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.

Note: If the property has a Type of String, you can select a subtype from the
Subtype droplist. This subtype is used for extended validation of the

property.
3. To encrypt a property, select the Encrypt box.
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4. To get more information on a particular property, left-click the entry in the
Description column for that property. If you have Extended Help installed, a
hot button will appear. When you click on the hot button, a Help window will
open and display details of the standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.
5. Choose to save or discard changes, as described for |“Setting standard connector]
[properties” on page 28]

If the Extended Help files are installed and the AdapterHelpName property is
blank, Connector Configurator Express will point to the adapter-specific Extended
Help files located in <ProductDir>\bin\Data\ App\Help\ <RegionalSetting>\.
Otherwise, Connector Configurator Express will point to the adapter-specific
Extended Help files located in

<ProductDir>\bin\Data\ App \Help\ <AdapterHelpName>\<RegionalSetting>\. See
the AdapterHelpName property described in the Standard Properties appendix.

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Connector-specific properties

Connector-specific configuration properties provide information needed by the
connector at runtime. They also provide a way of changing static information or
logic within the connector without having to recode and rebuild the connector.

Table 6 lists the connector-specific configuration properties for the connector. See
the sections that follow for explanations of the properties.

Table 6. Connector-specific configuration properties

Name Possible values Default value Required?
ArchivingEnabled] true or false true Yes
EventLoa Name and location of file event.log No
EventRecovery abort or retry retry Yes
FTPPollFrequency| number of poll cycles No
GenerateTemplate] BOName No
OutputLog]| File that registers the next Output.Log No

sequence number for each
incoming business object
during request processing

Number of events processed 25 No
at each poll

SortFilesOnTimestamp|  true or false False No

NoPoll true or false False No

ArchivingEnabled: Turns on archiving. If this property is set to true, the event file
is archived in the archive directory with the specified extension. If this property is
set to false, the event file is not archived. In this case, the connector deletes the file
after sending all events to the integration broker. For more information, see
[‘Specifying event archiving” on page 57|
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The default value is true.

EventLog: Provides file storage location for events that are generated by the
connector. This file is located in the JText subdirectory in the connectors directory
where the product is installed.

The default value is event.log.

EventRecovery: Specifies recovery behavior. If this property is set to retry, the
connector uses the event.log file to recover failed events. If this property is set to
abort, the connector terminates when it encounters a failed event. For more
information, see [“Event log file” on page 80,

The default value is retry.

FTPPollFrequency: Determines how frequently the connector polls an FTP server
measured in the number of standard poll cycles. For example, if Pol1Frequency
standard configuration property is set to 10000, and FTPPol1Frequency is set to 6,
the connector polls the local event directory every 10 seconds and polls the remote
directory every 60 seconds. The connector performs FTP polling only if you specify
a value for this property. If FTPPol1Frequency evaluates to 0 or blank, the connector
does not perform FTP polling. By default it does not.

There is no default value for this property.

GenerateTemplate: Enables the connector to generate a template for each
supported business object after connector startup. The syntax for this property is
BOName; BOName where the name of a specific business object is substituted for
BOName. For example, to generate two templates, one for a Customer business
object and one for an Item business object, specify Customer;Item. For more
information, see [“Generating sample business objects for testing” on page 76

There is no default value for this property.

OutputLog: Specifies the name of the file that stores the sequence number that
the connector uses to create unique output files for each type of business object
during request processing. The format of the file is:

BusinessObjectName = NextSequenceNumber

where BusinessObjectName is the name of the request business object, and
NextSequenceNumber represents the sequence number of the most recently received
business object, incremented by one. For example, if the connector is processing
Customer and Item business objects, the output log file might contain the
following:

Customer = 12
Item = 2

This file indicates that the connector has already processed 11 Customers and 1
Item. The next Customer and Item business objects will be written to the
Customer_12.out and Item 2.out files, respectively. When it receives a request
Order business object, the connector adds a new row to the output log file and
writes the business object to the Order_1.out file.

If FileSeqEnabled meta object is set to true, the connector uses this sequence

number to uniquely name the output files that it creates for each business object.
The connector names each output file by appending an underscore (_) and the
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sequence number to the business object’s name or to a file whose name is specified
in the OutputFileName meta-object attribute. Because the output log is stored in
user-readable format, you can use a standard text editor to read the file or to reset
its value.

For more information on the OutputFileName attribute, see [“Specifying the name|
of the output file” on page 54 For more information about the output log, see
“Specifying request processing” on page 58] For information on returning the
generated file’s name, see[’Returning a file’s name” on page 60

The default is Qutput.Log.

PollQuantity: Specifies the number of events to process for each poll. The
connector poll method retrieves the specified number of event records and
processes them in a single poll. Processing multiple events per poll can improve
performance when the application generates large numbers of events. However,
because integration-broker requests are blocked while the poll method is
processing events, do not set the number of events too high. If each poll call takes
a long time, it delays integration-broker request operations. For more information,
see [“Tuning the performance of the JText connector” on page 75.

The default value is 25.

SortFilesOnTimestamp: Allows the adapter to pick up event files based on the
timestamp. This property is ideally set to true when there are only a few huge
event files picked up by the adapter during polling. When there are a lot of small
event files, this value should be set to false in order to avoid the excess time taken
to sort the files at each poll.

The default value is False.

Note: Sorting based on the timestamp is supported only on Windows, i5/0S, and
Linux platforms. Sorting based on timestamp is not supported on MVS
platforms. Also, the JText adapter can poll remote files based on the
timestamp from FTP site only if the FTP server supports the mdtm
(modification date and time) command.

NoPoll: If this property is set to true, then the adapter will not perform event
processing and the adapter can only be used for request processing.

The default value is False.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first

value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
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check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method
Refer to the descriptions of update methods found in the Standard Properties
appendix.

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications.

InterChange Server Express as the broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop list displays,
showing all the business object definitions that exist in the System Manager
project.

2. Click on a business object to add it.

3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to an ICL (Integration Component
Library) project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to
use that business object for delivering data to an application via the connector
agent.

Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.
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To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps for InterChange Server Express

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:
* Business Object Name

These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps

The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit Binding
In some cases, you may need to explicitly bind an associated map.

Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.
If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.

If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.
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To explicitly bind a map:

1. In the Explicit column, place a check in the check box for the map you want
to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator Express window, click Save
to Project.

4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.

Security for InterChange Server Express

You can use the Security tab in Connector Configurator Express to set various
privacy levels for a message. You can only use this feature when the
DeliveryTransport property is set to JMS.

By default, Privacy is turned off. Check the Privacy box to enable it.

The Keystore Target System Absolute Pathname is:
* For Windows:
<ProductDir>\connectors\security\<connectorname>.jks
* For Linux:
/ProductDir/connectors/security/<connectorname>.jks
* For i5/0S:
/ProductDir/Connectors/security / <connectoryname>.jks

This path and file should be on the system where you plan to start the connector,
that is, the target system.

You can use the Browse button at the right only if the target system is the one
currently running. It is greyed out unless Privacy is enabled and the Target System
in the menu bar is set to Windows.

The Message Privacy Level may be set as follows for the three messages categories
(All Messages, All Administrative Messages, and All Business Object Messages):

“ur

. is the default; used when no privacy levels for a message category have been
set.

* none
Not the same as the default: use this to deliberately set a privacy level of none
for a message category.

* integrity
* privacy
* integrity_plus_privacy

The Key Maintenance feature lets you generate, import and export public keys for
the server and adapter.

* When you select Generate Keys, the Generate Keys dialog box appears with the
defaults for the keytool that will generate the keys.

* The keystore value defaults to the value you entered in Keystore Target System
Absolute Pathname on the Security tab.

* When you select OK, the entries are validated, the key certificate is generated
and the output is sent to the Connector Configurator Express log window.
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Before you can import a certificate into the adapter keystore, you must export it
from the server keystore. When you select Export Adapter Public Key, the Export
Adapter Public Key dialog box appears.

* The export certificate defaults to the same value as the keystore, except that the
file extension is <filename>.cer.

When you select Import Server Public Key, the Import Server Public Key dialog
box appears.

e The import certificate defaults to <ProductDir>\bin\ics.cer (if the file exists on
the system).

* The import Certificate Association should be the server name. If a server is
registered, you can select it from the droplist.

The Adapter Access Control feature is enabled only when the value of
DeliveryTransport is IDL. By default, the adapter logs in with the guest identity. If
the Use guest identity box is not checked, the Adapter Identity and Adapter
Password fields are enabled.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):
Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

* To File:
Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. Logging or tracing message are written
to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties.
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Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator Express saves the file in the broker
mode that you selected during configuration. The title bar of Connector
Configurator Express always displays the broker mode (InterChange Server
Express) that it is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

* From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.

* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

* You can also save it to a WebSphere Application Server project if you have set
one up.

For details about using projects in System Manager, and for further information
about deployment, see the System Implementation Guide.

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file.

To change your broker selection within an existing configuration file (optional):

* Open the existing configuration file in Connector Configurator Express.

* Select the Standard Properties tab.

* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker.
When you change the current value, the available tabs and field selections in the

properties window will immediately change, to show only those tabs and fields
that pertain to the new broker you have selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTEF-8 encoding.

Connector Configurator Express supports non-English characters in:
* All value fields
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* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the
drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.

For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en_US</DefaultValue>
</ValidValues>
</Property>

Starting the connector

A connector must be explicitly started using its connector start-up script. On
Windows systems the startup script should reside in the connector’s runtime
directory:ProductDir\connectors\connNamewhere connName identifies the connector.

On Linux systems the startup script should reside in the ProductDir/bin directory.
On i5/0S systems the startup script should reside in the
/QIBM/UserData/WBIServerd4/<instance>/connectors/<ConnInstance/ with which

the connector runs.

The name of the startup script depends on the operating-system platform, as

shows.

Table 7. Startup scripts for a connector

Operating system Startup script
Linux-based systems connector_manager
i5/0S start_connName.sh
Windows start_connName .bat

When the startup script runs, it expects by default to find the configuration file in
the Productdir (see the commands below). This is where you place your
configuration file.

Note: You need a local configuration file if the adapter is using JMS transport.
Starting the connector on a Windows system:
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* From the Start menu, select Programs>IBM WebSphere Business Integration
Server Express>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Server Express”. However, it can be customized.
Alternatively, you can create a desktop shortcut to your connector.

¢ From the Windows command line: start connName connName brokerName
{-cconfigFile}.

* On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for an
Auto service) or when you start the service through the Windows Services
window (for a Manual service).

Starting the connector on a Linux-based systems:
* From the command line type:
connector_manager -start connName brokerName [-cconfigFile ]

where connName is the name of the connector and brokerName identifies your
integration broker.

* For InterChange Server Express, specify for brokerName the name of the
InterChange Server Express instance.

Starting the connector on an i5/0OS system:

* From the Windows system where the WebSphere Business Integrations Server
Express Console is installed, select IBM WebSphere Business Integration Server
Express>Toolset Express>
Administrative>Console. Then specify the OS/400 or i5/0S system name or IP
address and a user profile and password that has *JOBCTL special authority.
Select the connector from the list of connectors, and click Start

* To automatically start the adapter using the Console, use the submit_adapter.sh
script. This is the only way the adapter will start using the subsystem within the
autostart job entry for the server.

* In Batch mode, from the i5/0S command line, you need to run the CL
command QSH and from the QSHELL environment. Run
/QIBM/ProdData/WBIServer44 /bin/submit_adapter.sh connName
WebSphereICSName pathToConnNameStartScript jobDescriptionName, where
connName is the connector name, WebSphereICSName is the Interchange Server
Express server name (default is QWBIDFT44), pathToConnNameStartScript is the
full path to the connector start script, jobDescriptionName is the name of the job
description to use in the QWBISVR44 library.

* In interactive mode, you need to run the CL command QSH and from the
QSHELL environment. Run
/QIBM/UserData/WBIServer44/WebSpherel CSName/connectors/connName/
start_connName.sh connNameWebsphereICSName [-cConfigFile] where connName is
the name of your connector and WebSphereICSName is the name of the
InterChange Server Express instance.

For more information on how to start a connector, including the command-line
startup options, refer to the System Administration Guide.

Stopping the connector

The way to stop a connector depends on the way that the connector was started.
* Windows:

— You can invoke the startup script which creates a separate “console” window
“" ”

for the connector. In this window, type “q” and press Enter to stop the
connector.
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— You can configure the connector to start as a Windows service. In this case,
the connector stops when the Windows system shuts down.

e i5/0S:

— If you started the connector using the Console, or using the
"submit_adapter.sh” script in QSHELL, then you can use one of two methods
to stop the connector:

— From the Windows system where the WebSphere Business Integration Server
Express Console is installed, select IBM WebSphere Business Integration
Express> Toolset Express>Administrative>Console. Then specify the OS/400
or i5/0S system name or IP address and a user profile and password that has
*JOBCTL special authority. Select the JText adapter from the list and select the
Stop button. Use the CL Command WRKACTJOB SBS (QWBISVR44) to
display the jobs to the Server Express Product. Scroll the list to find the job
with the jobname that matches the job description for the connector. For
example, for the JText connector the jobname is QWBIJTEXTC. Select Option 4
on this job, and press F4 to get the prompt for the ENDJOB command. Then
specify *IMMED for the Option parameter and press enter.

Note: The connector will end when the QWBISVR44 subsystem has ended.

— If you used the start_connName.sh script to start the adapter from QSHELL,
press F3 to end the connector. You can also stop the agent, by using a script
named stop_adapter.sh located in the /QIBM/ProdData/WBIServer44 /bin
directory.

e Linux:

Connectors run in the background so they have no separate window. Instead,
run the following command to stop the connector:

connector_manager -stop connName

where connName is the name of the connector.

Creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Create a new directory

¢ For Windows Platforms:
ProductDir\ connectors\ connectorInstance

If the connector has any connector-specific meta-objects, you must create a
meta-object for

the connector instance. If you save the meta-object as a file, create this directory
and store

the file here:

ProductDir\repository\connectorInstance

where connectorlnstance uniquely identifies the connector instance.
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You can specify the InterChange Server Express server name as a parameter of
startup.bat; an
example is: start_]Text.bat connName serverName.

e For i5/0S Platforms:
/QIBM/UserData/WBIServerd4/WebShereICSName/connectors/connectorInstance

where connectorInstance uniquely identifies the connector instance and where
WebSphereICSName is the name of the Interchange Server Express instance with
which the connector runs.

If the connector has any connector-specific meta-objects, you must create a
meta-object

for the connector instance. If you save the meta-object as a file, create this
directory and

store the file here:

/QIBM/UserData/WBIServer44/WebSphereICSName /repository
/connectorInstance where WebSphere[CSName is the name of the Interchange
Server Express

instance with which the connector runs.

* For Linux Platforms:
ProductDir/connectors/connectorInstance
where connectorInstance uniquely identifies the connector instance. If the
connector has any connector-specific meta-objects, you must create a meta-object
for the connector instance. if you save the meta-object as a file, create this
directory and store the file here: ProductDir/repository/connectorInstance.
You can specify the InterChange Server Express servername as a parameter of
connector_manager; an example is connector_manager -start connName
WebSphereICSName [-cConfigFile].

Create business object definitions

If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

2. Files for the initial connector should reside in the following directory:

ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition

You create a configuration file (connector definition) for the connector instance in
Connector Configurator Express. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script

To create a startup script:
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1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. Put this startup script in the connector directory you created in
|business object definitions” on page 40.|

3. (For Windows only.) Create a startup script shortcut.

4. (For Windows only.) Copy the initial connector’s shortcut text and change the
name of the initial connector (in the command line) to match the name of the
new connector instance.

5. (For i5/0S only.) Create a job description for the connector using the
information below:
CRTDUPOBJ(QWBIJTEXT) FROMLIB(QWBISVR44)OBJTYPE(*JOBD)
TOLIB (QWBISVR44) NEWOB](newjtextname) where newjtextname is a
10-character name that you use for the job description for your new connector.

6. (For i5/0S only.) Add the new connector to the WebSphere Business
Integration Server Express Console. For information about the WebSphere
Business Integration Server Express console, refer to the online help provided
with the Console.

Adding supported business objects

By default, the JText connector supports the MO_JTextConnector_Default and
MO_DataHandler_Default meta-objects. To fully configure the connector, use
Connector Configurator Express to add other required business objects to its list of
supported business objects. Depending on how you use the connector, you may
need to add all or many of the following business objects:

* The meta-object for the data handler (which is specified in the EventDataHandler
and OutputDataHandler attributes of the MO_JTextConnector_Default
meta-object). By default, these attributes specify the
MO_DataHandler_DefaultNameValueConfig data-handler meta-object, which
represents the NameValue data handler. For more information, see
[data handler” on page 73

* MO_JTextConnector_BOName BusObjName — if you create meta-objects for specific
business objects. For more information, see [“Creating a JText meta-object for a|
[specific business object” on page 73]

* Business objects that are to be read from or written to a file. For more
information, see [“Business objects used by the JText connector” on page 3
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Chapter 4. Using JText connector meta-objects

A meta-object is a WebSphere Business Integration Adapters business object that
contains configuration information used by a connector or a data handler. The
JText connector requires each of its supported business objects to have an
associated JText meta-object for that business object type. This top-level meta-object
contains at least one child meta-object.

* The connector uses the top-level JText meta-object to obtain configuration
information such as which data handler to use for data conversion, the paths of
the business object’s event, archive, and output directories, the file extensions for
its event, archive, and output files, information that is required if the connector
is processing files on an FTP system, and whether the connector generates
unique file identifiers for its output files.

* The connector uses a child meta-object to specify configuration values for the
data handler to use when converting data between the business object and a
string or byte array. By default, the top-level meta-object specifies the
NameValue data handler to convert data.

To provide different configuration information for each business object that the
connector supports, you can create a custom top-level JText meta-object for each
one. Because each top-level meta-object specifies its own data-handler meta-object,
the connector can process each type of business object in a different format. The
data-handler meta-object eliminates the need to edit a business object definition or
to modify the connector itself when you introduce new data formats or make
changes to existing formats.

Meta-objects are loaded into memory at startup, making their configuration
information available to the connector. Note that meta-objects are not sent to the
integration broker for processing. They affect the behavior only of the connector.

This chapter describes how to configure the JText connector by using JText
meta-objects. For information on using data-handler meta-objects, see the Data
Handler Guide. Topics included in this chapter include:

* |"JText meta-object naming conventions”]

* |"JText meta-object structure” on page 44|

* [“Common configuration tasks” on page 55|

JText meta-object naming conventions

The name of a top-level JText meta-object has three components, as illustrated by
the name of the default top-level meta-object, MO_JTextConnector _Default. The
components of a top-level JText meta-object name are as follows:

* MO_ is a prefix that indicates a meta-object.

* ConnectorInstanceName_ specifies the name of the connector instance, such as
JText. This name is configurable to support the use of multiple connector
instances. For example, a connector named JText2 might have a meta-object
named MO_JText2Connector_Default.

* Default specifies the name of the associated business object. To create a
meta-object for a specific business object, change the string Default to the name
of the business object, as in M0_JTextConnector_Customer for a business object
named Customer. You can include additional components and underscores in the
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meta-object name. The connector uses default meta-objects whenever
corresponding business object-specific meta-objects do not exist.

For information on creating meta-objects for a specific business object, see
[‘Creating a JText meta-object for a specific business object” on page 73|

JText meta-object structure

A JText meta-object has a hierarchical structure. The default top-level meta-object is
named MO_JTextConnector_Default. Two attributes of the top-level meta-object,
EventDataHandler and OutputDataHandler, represent child meta-objects that
provide configuration information for the data handler that the connector uses. The
connector uses the data handler to convert data between business objects and
strings or byte arrays.

By default, both of these attributes specify the same data-handler meta-object
(MO_DataHandler_DefaultNameValueConfig). This data-handler meta-object calls the
NameValue data handler to actually convert the data. In other words, the delivered
default configuration specifies that event and output file conversion use the same
data handler. For information on instantiating a data handler, see the Data Handler
Guide.

Note: Because formatter usage has been deprecated in favor of data handler usage,
the EventFormat and OutputFormat attributes that formerly represented a
formatter have been removed from the M0_JTextConnector_Default
meta-object. To use a formatter, you must:

e add the EventFormat and OutputFormat attributes to the top-level meta-object
* specify the appropriate business object as the Type of these attributes

* change the Type of the EventDataHandler and OutputDataHandler attributes to
String

For information on using a formatter, see the documentation for the 3.0.0 or 2.3.0
release of the JText connector.

shows the hierarchical structure for the default JText meta-objects and
each attribute name and type.
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Top-level Jtext meta-object

MO_JTextConnector_Default

Version = 1.0.0

DummyKey String

EventDataHandler MO_DataHandler_DefaultNameValueConfig

OutputDataHandler MO?DataHandIerﬁDefaultNamw

DataEncoding String

DataProcessingMode String

OriginalArchiveExt String

UnsubscribedArchiveExt String Default datd handler meta-object

PartialArchiveExt String

OutputDir String MO_DataHandler_DefaultNameValueConfig

OutputExt String Version = 1.0.0

OutputFileName String ValidateAttrCount String

FileSeqEnabled String DefaultVerb String

ArchiveDir o Str!ng SkipCxIgnore String

SuccessArchiveDir String .

FailArchiveExt String Cxignore String
: ) CxBlank String

EventDir String )

EventExt String CxBlankValue Strfng

EndBODelimiter String ClassName String

FixedBOSize String DummyKey String

FTPUserld String ObjectEventld String

FTPPassword String

FTPLocalEventDir String

FTPRenameEXxt String

FTPEventFileMask String

FTPOSPIatform String

FTPArchiveDir String

FTPTransferType String

FTPDataStructure String

StagingDir String

FTPFileListingFormat String

IncludeEndBODelimiter String

FTPPollTerminatelfServerDown String

FTPRequestTerminatelfServerDown String

FTPKeepConnectionOpen String

ObjectEventld String

Figure 5. Hierarchical Structure of the JText meta-object

Creating custom meta-objects

MO_JTextConnector Default, as the top-level JText meta-object, contains
configuration information and child meta-objects for the connector. You can create
separate top-level meta-objects for each type of business object that the connector
handles. These custom meta-objects can contain the same or different child
meta-objects to configure the type of data handler. For example, to configure
processing differently for the Customer and Item business objects, create the
MO_JTextConnector_Customer and MO_JTextConnector_Item meta-objects, and design
these top-level meta-objects to contain different data-handler meta-objects.

At initialization, the connector retrieves a list of its supported meta-objects and

business objects from the integration broker. From the names of these objects, the
connector determines which business objects have their own associated top-level
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meta-objects. At runtime, the connector matches the name of a request business
object with one of its supported meta-objects to locate the appropriate
configuration information.

For example, assume that the connector supports the following meta-objects:
e MO_JTextConnector_Default

e MO_JTextConnector_Customer

* MO_JTextConnector_Item

and the following business objects:
* Customer

e Item

* Order

When the integration broker sends a request Customer business object, the
connector uses the configuration information specified in the
MO_JTextConnector_Customer meta-object. When the integration broker sends a
request Order business object, the connector uses the configuration information
specified in the MO_JTextConnector_Default meta-object.

MO _JTextConnector Default attributes

This section describes the attributes in the MO_JTextConnector_Default
meta-objects.

Note: All values in an attribute’s DefaultValue property are case-sensitive.
Directory information must specify the absolute path of a directory.

and the following sections describe the functionality of each attribute in the
MO_JTextConnector_Default meta-object. Among other information, this table
includes the value provided for each simple attribute’s DefaultValue property. You
can replace the product-delivered value with your own value.

Table 8. Attributes in the MO_dJTextConnector_Default meta-object definition

Attribute name Description

ArchiveDir Specifies the absolute path of the Archive directory. The directory must
already exist. The delivered default values are:

Linux: /tmp/JTextConn/Default/archive
Windows: C:\temp\JTextConn\Default\Archive
i5/0S: /QIBM/UserData/WBIServerd4/<instance>/connectors/JText/archive

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an JText connector standard property.

DataEncoding DataEncoding is the encoding to be used to read and write business object
strings. If this property is not specified in the static meta-object, the
connector tries to read or write the business object string without using
any specific encoding. You can specify any Java-supported encoding set for
this attribute.
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

DataProcessingMode

DummyKey

EndBODelimiter

EndOfFileDelimiter

EventDataHandler

Description

This attribute provides new flexibility for reading and writing binary files.
When set to Binary, this MO property enables JText to read and write
binary files from the file system while calling the appropriate data handler
interface for BO to byte array and vice versa transformations. The
traditional setting for this is Text. In Text mode, the BO to String and vice
versa data handler interface is used. When the property is not set, it
defaults to Text. Binary mode should only be used with a data handler
that appropriately implements the getBO(byte[]) and
getByteArrayFromB0() methods.

This attribute exists to satisfy the requirement that one attribute in every
business object definition have the Key property enabled.

Specifies a delimiter that separates business objects within an input file.
For more information on the EndBODelimiter attribute, see

|specific business objects” on page 63|

If you do not provide a default value during configuration and the
DataProcessingMode is set to Text, the property defaults to the following
value: <EndB0:B0Name>. When DataProcessingMode is binary, the property
defaults to the following value: FFO1.

Note: Since the NameValue data handler is set as the default data handler,
the EndBODelimiter value is set to <EndB0:B0Name>. If you would like to use
another data handler, such as the Delimited data handler, you will have to
specify the corresponding value. For the Delimited data handler, the string
EOL is a valid EndBODelimitervalue.

When DataProcessingMode is binary, and FTPDataStructure is Record, both
EndBODelimiter and EndOfFileDelimiter are used. This property is set to
the hexadecimal byte that is used for the end of file marker in the record
file. If it is not set, the default, FF02, is used.

Represents a child meta-object whose attributes provide configuration
values for the data handler to be used for event processing (business object
string converted to business object). The delivered default value is
MO_DataHandler_DefaultNameValueConfig
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

EventDir

EventExt

FaiTArchiveExt

FileSeqEnabled

FixedB0Size

Description

Specifies the absolute path of the Event directory. The directory must
already exist. If you create separate meta-objects for different business
objects, and you specify the same EventDir path for both, you must specify
unique values for the EventExt attribute in each meta-object. For more
information, see“Specifying event directories and extensions” on page 56}
To configure the connector to use a remote FIP file system for event
processing, specify the FTP URL in this attribute. Optionally, you can use
this attribute to specify the following additional information in the URL:

¢ the id and password of a user with privileges to connect to the FTP
server and perform FTP operations; if not specified in EventDir, must be
specified in|FTPUserId|and [FTPPassword|.

¢ the FTP port; if not specified in EventDir, the connector uses the default
FTP port.

¢ the remote event directory; if not specified in EventDir, the connector
polls the event files from the directory to which the connection is
established to the FTP server.

Syntax for specifying FTP information in the EventDir attribute is:
ftp://[UserId:password@] FTPserver[:port] [RemoteEventDirectory]

For more information, see|”Remote event processing” on page 66 To
specify local file information in the EventDir attribute, use the full path of
the file. Alternately, you can use a FILE URL, which uses the following
format:

[file://]FullPathname

The delivered default values are:
Linux:
/tmp/JTextConn/Default/event

Windows: C:\temp\JTextConn\Default\Event i5/OS:

/QIBM /UserData/WBIServer44 /<instance>/connectors/JText/event

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

Note: A new Connector-specific boolean property, "NoPoll”, has been
introduced, to optionally turn off polling. The default value is false. When
set to true, the adapter only processes requests and does not poll.

Specifies the extension of the file used for event notification. If no value is
specified, the JText connector polls for files with no file extension. For more
information, see|’Specifying multiple event files or multiple event|
|directories” on page 62}

Note: The use of an asterisk (*) for this attribute to specify that the
connector poll for all files in a single event directory regardless of their
extension is no longer supported. The delivered default value is in.
Specifies the file extension used to archive business objects that were not
successfully processed. For more information, see [“Specifying event|
larchiving” on page 57} The delivered default value is fail.

Specifies filename sequencing, which outputs each business object to a
separate file. The file’s name includes a unique sequence number. For more
information, see|“Specifying request processing” on page 58 The delivered
default value is true.

When present with a valid value, this meta-object property overrides the
EndBODelimiter property, and provides users an alternative to the
traditional delimiter based BO parsing.
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

FTPArchiveDir

FTPDataStructure

Description

Specifies the relative path of the archive directory on the FTP server. The
directory must already exist. There are several options for using this
attribute to specify archiving:

Specifying a value for this attribute but no value for the FTPRenameExt
attribute causes the connector to append a timestamp to the event
filename and move it to the FTP server archive directory specified in this
attribute.

Specifying a value both for this attribute and the FTPRenameExt attribute
causes the connector to rename the processed event filename with a
timestamp and the value specified in FTPRenameExt, and move it to the
FTP server archive directory specified in this attribute.

Specifying no value either for this attribute or the FTPRenameExt attribute
causes the connector to delete the processed event file without archiving
it.

Specifying no value for this attribute but specifying a value for the
FTPRenameExt attribute causes the connector to rename the processed
event file, adding a timestamp and the value specified in FTPRenameExt,
and move it to the directory specified in the attribute.
Specifying / (slash) for this attribute but no value for the FTPRenameExt
attribute causes the connector to move the processed event file to the
root directory on the FTP server.

Specifying / (slash) for this attribute and a value for the FTPRenameExt
attribute causes the connector to rename the processed event filename
with the extension specified in FTPRenameExt, and move it to the root
directory on the FTP server.

For more information, see[“Specifying event archiving” on page 57} There
is no delivered default value for this attribute.

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

This attribute is of type String. The user can specify the FTP data structure
(either File or Record) to get or put files from or to the remote site. If
nothing is specified, Jtext will use 'File as default value.
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

FTPEventFileMask

FTPFileListingFormat

FTPGetQuantity

FTPKeepConnectionOpen

Description

Uses embedded wildcard characters to specify the mask or prefix of remote
FTP files for event processing. Specify a value for this attribute only to
identify the file mask on a mainframe that does not adhere to the same
naming standards that apply to Windows, Linux, or i5/OS systems. Using
wildcard characters in the file name enables you to specify multiple files
for event processing. For example, you can use the following format to
specify multiple event files: ACT.Z1UC. INPT*For more information, see

“Identifying files on a mainframe: Optional configuration” on page 69|

There is no delivered default value.

If you are polling, you should provide a very specific mask. For example, if
you want to poll all the following event files: USER.JTEXT.TESTOO1.EVENT,
USER.JTEXT.TESTO02.EVENT, USER.JTEXT.TESTOO3.EVENT,
USER.JTEXT.TESTO04.EVENT, and the FTPArchiveDir is set as / or left blank,
and the FTPRenameExt is set as RENAME, then these files would get archived
as the following: USER.JTEXT.TESTOO1.RENAME,
USER.JTEXT.TESTOO02.RENAME, USER.JTEXT.TEST003.RENAME. So, if you
provide an FTPEventFileMask=USR.JTEXT.TEST*.=, all the events would get
picked up on the first poll. All the archived files would get picked up at
the next poll, since even they conform to the same file mask. In order to
avoid this, you must provide a very specific mask. For example, like
USR.JTEXT.TEST*.EVENT, so that USR.JTEXT.TEST*.RENAME is not picked up
during polling.

Note: Do not specify a mask that is applicable for both event files and
archived files.

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

Specifies the format in which the JText connector should expect file
information to appear when reading in files. This enables the connector to
read in files in different locales where date and time information may be
stored in different orders within the file format information. To configure
the connector to use the format for your locale, specify a
semicolon-delimited series of characters that represent the order in which
file attributes occur; below is a list that associates the possible characters
with the file attributes they represent. P Permission L Links U
User G Group S Size D Date M Month T Time N Name

A suitable value for this attribute, then, might be P:L:U:G:S:D:M:T:N.
Determines the number of files retrieved from the remote FTP URL with
each remote poll.

Set the Default Value property of this attribute to the value true to cause
the JText connector to maintain its connection with an FTP site. If this
attribute is set to the value true then the connector only closes the
connection when the connector terminates or if the FTP server closes the
connection itself (due to a configured timeout, for instance). The connector
checks to make sure that the connection is still alive each time it performs
a remote operation in order to handle the situation when the FIP server
might have closed the connection due to a timeout. If the connection has
been closed then the connector re-establishes it. Set the Default Value
property of this attribute to the value false to cause the JText connector to
open a connection with the FTP server each time it performs an operation
and to close the connection when it is finished. Configuring the connector
to keep the connection alive can improve the performance of the connector
when performing request processing on FIP sites.
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

FTPLocalEventDir

FTPOSPT1atform

FTPPassword

FTPPol1TerminateIfServerDown

FTPRenameExt

FTPRequestTerminatelfServerDown

FTPTransferType

Description

Specifies the local system directory into which the connector downloads
event files from the FTP site. You must specify a value for this attribute to
enable the connector to process events using FIP. For more information,
see [‘Specifying the local directory” on page 67} There is no delivered
default value.

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

Use this attribute only if configuring the connector to use a remote FIP file
system where the remote FTP server is an MVS platform. In this case,
specify the value of this attribute as MVS. Case is not significant. For more
information, see|“Specifying a remote FIP file system” on page 66} There is
no delivered default value.

Specifies the password of the user who has privileges to connect to the FTP
server and perform FTP operations. You need not specify a value for this
attribute if the password is included in the URL specified in the [EventDif
or FiutputDi ;l attribute. For more information, see|“Specifying the FTP URL|
land login information” on page 66} There is no delivered default value for
this attribute.

Specifies the behavior of the connector when configured to poll the FTP
site for events and the FTP site is unavailable. If the Default Value property
of the FTPPollTerminatelfServerDown attribute is set to the value true and
the FTP site is unavailable when the connector attempts a poll call, then
the connector terminates. If the Default Value property of the
FTPPollTerminatelfServerDown attribute is set to the value false and the
FTP site is unavailable when the connector attempts a poll call, then the
connector does not terminate.

There is no delivered default value.

Specifies the file extension or suffix that the connector uses to rename the
remote FTP file after the connector has polled for it. Renaming the file
prevents the connector from polling the same file in the next poll cycle.
Alternatively, you can configure the connector to rename the processed
event file and move it to an archive directory. For more information, see
the |Fa1' 1Archi veExtl attribute. For more information, see |"Identifying filesl
[on a mainframe: Optional configuration” on page 69 There is no delivered
default value.

Specifies the behavior of the connector when configured to perform request
processing and communicate with an FTP site, and the FTP site is
unavailable. If the Default Value property of the
FTPRequestTerminatelfServerDown attribute is set to the value true and
the FTP site is unavailable when the connector attempts to perform request
processing, then the connector terminates. If the Default Value property of
the FTPRequestTerminatelfServerDown attribute is set to the value false
and the FTP site is unavailable when the connector attempts to perform
request processing, then the connector does not terminate.

There is no delivered default value.

This JText meta-object property is used during both event and request
processing. The possible values for this property are Binary and ASCII. The
property dictates the transfer type JText will use when remotely placing or
retrieving files from an FTP server. When the property does not exist, the
adapter behavior defaults to Binary.

Chapter 4. Using JText connector meta-objects 51



Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

FTPUserId

IncludeEndBODelimiter

LargeObject

MVSSiteCommand

ObjectEventID

OriginalArchiveExt

QutputDataHandler

Description

Specifies the name of the user who has privileges to connect to the FTP
server and perform FTP operations. You need not specify a value for this
attribute if the Userld is included in the URL specified in the or
attribute. The connector ignores this attribute if it does not find
an FTP URL in the attribute (during event processing) or
OutputDir]attribute (during request processing). For more information, see
“Specifying the FTP URL and login information” on page 66} There is no
delivered default value for this attribute.

Specifies whether or not the value specified for the
meta-object attribute is included in the string written to a file by the JText
connector. If the Default Value property of this attribute is set to true then
the connector includes the value specified for the EndBODelimiter attribute
when it writes files. If the Default Value property of this attribute is set to
false then the connector does not include the value specified in the
EndBODelimiter attribute when it writes files.

A flag used to turn on the large object optimization features of JText
adapter (when set to true). Setting this flag to true will result in the
following changes in the behavior of the archiver:

1. If an event file has multiple business objects, the archiving will be done
only after all the business objects for that event file are processed.

2. The original file will not be archived in case the processing of all
business objects in that event file results in failure or unsubscribed
status.

Also an extra log file will be created internally for keeping track of the
archive status.

Used for issuing MVS FTP site commands. The site command should be
specified without SITE or QUOTE keywords. An example for site
command value is:LRECL=<value> BLKSIZE=<value>, where <value>
represents the site command arguments passed.

Placeholder not used by the connector in a meta-object but required by the
integration broker. This attribute must be the last attribute in the
meta-object. There is no delivered default value.

Specifies the file extension used to archive the original event file, which
preserves the entire event file for reference in case any of its business
objects fail processing or are unsubscribed. For more information, see
[“Specifying event archiving” on page 57} The delivered default value is
orig.

Represents a child meta-object whose attributes provide configuration
values for the data handler to be used for service call requests (business
object converted to business object string). The delivered default value is
MO_DataHandler_DefaultNameValueConfig.
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Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

QutputDir

QutputExt

QutputFileName

PartialArchiveExt

Description

Specifies the absolute path of the Output directory. The directory must
already exist. To configure the connector to use a remote FIP file system
for request processing, specify the FTP URL in this attribute. Optionally,
you can use this attribute to specify the following additional information in
the URL:

* the Userld and password of a user with privileges to connect to the FTP
server and perform FTP operations; if not specified in EventDir, must be
specified in|FTPUserId|and [FTPPassword|.

* the FTP port; if not specified in OutputDir, the connector uses the default
FTP port.

* the remote output directory; if not specified in QutputDir, the connector
loads request files into the default connection directory (the directory on
the FTP server to which the connection is established).

Syntax for specifying FIP information in the OutputDir attribute
is:ftp://[UserId:password@]FTPserver[:port]For more information, see
|“Remote request processing” on page 70 To specify local file information
in the OutputDir attribute, use the full path of the file. Alternately, you can
use a FILE URL, which uses the following format:

[file://]FullPathname

The delivered default values are:

Linux: /tmp/JTextConn/Default/out
Windows:c:\temp\JTextConn\Default\0uti5/OS:
/QIBM/UserData/WBIServer44/<instance>/connectors/JText/out

BiDi supported for Windows. All BiDi enabled properties will
betransformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

Specifies the extension of the file used for request processing. The
delivered default value is out.

Note: If contains no extension, but the attribute
does contain an extension, the output file is generated with both the file
name and the extension. If neither contain an extension, the output file is
generated without one.

Specifies the name and path of the output file into which the connector
writes the incoming business object during request processing. If the
attribute contains a valid output directory, the output file is
generated into the specified directory. For more information, see
|“Specifying the name of the output file” on page 54|

Note: If|QutputFileName|and [QutputExt] attributes do not contain an
extension, the output file is generated without an extension.

The delivered default value is Native.

BiDi supported. If the BiDi format used in the target platform is different
from the Windows 2003 format, values for these meta-data attributes will
be transformed.

Specifies the file extension used to archive the successfully processed
business objects (when the event file contains multiple business objects, not
all of which process successfully). For more information, see

[event archiving” on page 57| The delivered default value is partial.

Chapter 4. Using JText connector meta-objects 53



Table 8. Attributes in the MO_JTextConnector_Default meta-object definition (continued)

Attribute name

StagingDir

SuccessArchiveExt

UnsubscribedArchiveExt

Description

Specifies a directory in which the connector should write files to before
moving them into the directory specified by the OutputDir attribute. This is
designed to handle environments where other software processes might be
monitoring and manipulating the directory into which the JText connector
outputs files (such as an FTP process that detects files created by the
connector and moves them to another location). In situations such as this,
there is a risk that the external process could move the file before it has
been completely written. You can specify a staging directory in the
StagingDir attribute, therefore, so that the connector writes the file
completely to the staging directory and then moves it to the output
directory when it is finished, eliminating the risk of the external process
picking up an incomplete file.

It is recommended that the staging directory and output directory be on
the same file system or drive to accommodate different operating systems’
approaches to file moving operations. The StagingDircan be a remote
directory. There is no delivered default value.

BiDi supported for Windows. All BiDi enabled properties will be
transformed from Windows BiDi format into the BiDi.Metadata format,
which is an e-Mail connector standard property.

Specifies the file extension used to archive all successfully processed
business objects. For more information, see|“Specifying event archiving” on|
The delivered default value is success.

Specifies the file extension used to archive all unsubscribed business
objects. For more information, see [“Specifying event archiving” on page 57|
The delivered default value is unsub.

Note: Attributes FTPTransferType, FTPDataStructure, DataProcessingMode,

EndOfFileDelimiter, and FixedBOSizeare not part of the JText meta-object as
delivered. To use these attributes, they need to be explicitly added to the
meta-object and their default values must be set.

Specifying the name of the output file
There are three ways to specify the name of the output file:

for details.

Use the OutputFileName attribute

Use this attribute when you want the connector to write each business object of
the same type to separate files with unique sequence numbers, or to append
multiple business objects to a single file with a specified name.

Use a dynamic child meta-object

Use a dynamic child meta-object when you want to dynamically generate an
output filename for each type of business object or to return the name of a
connector-generated output file. See [“Using a dynamic child meta-object” on|

There are several ways to use the OutputFileName attribute to specify the name of
the output file:

If OutputFileName is set to the string Native and the FileSeqEnabled attribute is
set to true, the connector sends the business object string to a unique file whose
name is derived from the name of the incoming business object, whose extension
is derived from the OutputExt attribute, and whose path is derived from the
OutputDir attribute. In this case, the connector’s default behavior is to write each
business object of the same type to separate files with unique sequence numbers.
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To cause the connector to overwrite the output file each time it receives business
objects of the same type, set the FileSeqEnabled attribute to false.

If OutputFileName is set to a string other than Native and the FileSeqEnabled
attribute is set to true, the connector handles the value of the output file in one
of the following ways:

— If QutputFileName contains an absolute path (including the filename and the
extension of the output file, for example, OutputFileName=
C:\temp\Out\test.out), the connector uses only this attribute to generate the
output file. In this case, the connector’s default behavior is to write each
business object of the same type to separate files with the specified name and
with unique sequence numbers.

— If OutputFileName contains the full path and the filename, but not the
extension, and the OutputExt attribute contains a value, (for example,
OutputFileName= C:\temp\Out\test and OutputExt=out), the connector uses
the value of both attributes to generate the output file. In this case, the
connector generates a file named C:\temp\Out\test_1.out.

— If OutputFileName contains the full path and the filename, but not the
extension, and the OutputExt attribute does not contain a value, the connector
generates the output file without any extension. In this case, the connector
generates a file named C:\temp\Out\test_1.

— If OutputFileName contains only the filename, and not the path or extension,
and the OutputDir attribute contains a value, the connector generates the
output file in the directory specified by OutputDir. If OutputExt contains a
value, the connector also uses that value. If not, it creates the filename
without any extension.

Note: If the connector is processing more than one type of business object and

OutputFileName is set to a string other than Native, each business object
must have its own top-level meta-object, which specifies a unique output
filename. For example, the meta-object used by the Customer business object
might be MO_JTextConnector_Customer, and the meta-object used by Item
might be MO_JTextConnector_Item. Set the value of the OutputFileName
attribute in each of these meta-objects to a unique value.

To cause the connector to append multiple business objects to a single file with
the specified name, specify a value for OutputFileName and set the
FileSeqEnabled attribute to false.

To cause the connector to overwrite the output file each time it receives business
objects of the same type, use a dynamic child meta-object. Specify its absolute
path and filename in the InFileName attribute and set the FilelWriteMode
attribute to “0”. For more information on using a dynamic child meta-object, see
[“Using a dynamic child meta-object” on page 4.

Native is a reserved word.

For more information, see |”Specifying request processing” on page SSI

Common configuration tasks

This section describes the most common configuration tasks.

[“Specifying event notification” on page 56|

“Specifying event archiving” on page 57

“Specifying request processing” on page 58|

[“Specifying multiple event files or multiple event directories” on page 62|
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« |"Polling for specific business objects” on page 63|

* |“Specifying a remote FTP file system” on page 66|

* |“Configuring secure FTP” on page 72|

* |“Specifying a data handler” on page 73|

+ |“Creating a JText meta-object for a specific business object” on page 73

+ |“Reading multiple business objects of different types from the same file” on|
page 74
* [“Specifying values for ObjectEventID attributes” on page 74|

» |“Setting up a second instance of a JText connector” on page 74|

* [“Tuning the performance of the JText connector” on page 75|

* |“Generating sample files for testing” on page 76|

* [“Generating sample business objects for testing” on page 76}

Specifying event notification

This section describes the following:

* [“Specifying event directories and extensions”]

+ |[“Configuring polling behavior” on page 56

Specifying event directories and extensions

If you send more than one type of business object to the connector for processing,
and each business object type has its own top-level meta-object, the combination of
values you specify for the EventDir and EventExt attributes must be unique for
each directory/extension pair for each business object.

In other words, if you specify the same event directory for two business object
types, you must specify different event extensions for these business objects. If you
specify the same extension for two business object types, you must specify
different event directories for these business objects.

For example, assume you have created the MO_JTextConnector_Customer and
MO_JTextConnector_Item meta-objects to provide configuration values for the
Customer and Item business objects, respectively. If you instruct the connector to
locate the input files for both business objects in the same directory (by specifying
the same path in the EventDir attribute), you must uniquely identify the input files
by specifying different values for the EventExt attribute.

Therefore, if the EventDir attribute evaluates to C:\temp\event for both Customers
and Items, the value of the EventExt attributes for these two business objects must
be different (such as in for Customer input files and inp for Items).

Note: A new Connector-specific boolean property, "NoPoll”, has been introduced,
to optionally turn off polling. The default value is false. When set to true,
the adapter only processes requests and does not poll.

Configuring polling behavior
To configure polling behavior, perform the following steps:

1. Configure the following attributes of the MO_JTextConnector_Default
meta-object:

* EventDir—Specify the absolute path of an existing directory whose files
trigger event notification.

¢ EventExt—The connector looks for files with the delivered-default extension
of in. If you use this attribute to specify a different extension, the connector
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looks for the specified extension. If you leave this attribute empty, the
connector polls for files with no extension.

* EventDataHandler—Specify the data handler to use for data conversion
during event notification.

2. Use Connector Configurator Express to configure the following connector
properties:
* PollFrequency—Specify the interval frequency.
* PollQuantity—Specify the number of events for each polling interval.
* Pol1EndTime—Specify the time to complete the polling of events.
¢ Pol1StartTime—Specify the time to begin the polling of events.

3. Establish read permissions on the event directory.

Specifying event archiving
Depending on whether all or some of the business objects in the event file process
successfully, the JText connector uses different extensions when it creates the
archive file for successfully processed business objects. The connector also writes
business objects that fail processing and those that are unsubscribed to differently
named archive files.

This section describes the following:

* [“Local archive filenames”|

+ |[“Configuring local archiving” on page 5§

Local archive filenames
If you retain the delivered default values for the archive extension attributes, the
connector creates archive files named as shown below:

* Event file has a single business object

After the JText connector processes an event file that contains a single business
object, it creates one of following files in the archive directory:

— filename_timestamp.success, to archive a successfully processed business
object

— filename_timestamp.fail, to archive a business object that was not
successfully processed

— filename_timestamp.unsub, to archive a business object to which it does not
subscribe

If the business object fails processing or is unsubscribed, the connector also
creates the filename_timestamp.orig file, which preserves the event file as the
connector originally received it.

* Event file has multiple business objects, all of which process successfully

After the JText connector successfully processes an event file with multiple
business objects, it creates filename_timestamp.success in the archive directory.

* Event file has multiple business objects, some of which are unsubscribed or fail
processing

After the JText connector processes an event file that contains multiple business
objects, it may create all of the following files in the archive directory:

— filename_timestamp.partial, to archive all business objects whose processing
was successful

— filename_timestamp.fail, to archive all business objects whose processing
was unsuccessful
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— filename_timestamp.unsub, to archive all business objects to which the
connector does not subscribe

— filename_timestamp.orig, to preserve the event file as the connector
originally received it

For example, assume that the LegacyApp.in file contains four business objects:
— Contract, which is successfully processed

— Customer, which fails formatting

— Order, which is successfully processed

— Item, to which the connector does not subscribe

In such a case, the connector creates the following files in the archive directory:
LegacyApp_timestamp.partial, which contains Contract and Order
LegacyApp_timestamp.fail, which contains Customer

LegacyApp_timestamp.unsub, which contains Item

— LegacyApp_timestamp.orig, which contains Contract, Customer, Order, and
Item

Configuring local archiving
To configure the connector for archiving, follow these steps:

1. Configure the following attributes of the MO_JTextConnector_Default
meta-object:

* ArchiveDir—Specify the absolute path of an existing local or FIP server
directory into which the connector is to place events (with file extensions that
indicate processing status) after they are processed.

* SuccessArchiveExt—Specify the extension for the file that contains the
successfully processed business objects (when all business objects process
successfully).

e PartialArchiveExt—Specify the extension for the file that contains all the
successfully processed business objects (when some of the business objects in
the event file do not process successfully).

* UnsubscribedArchiveExt—Specify the extension for the file that contains the
business objects to which the connector does not subscribe.

* OriginalArchiveExt—Specify the extension for the file that preserves all the
business objects that were contained in the event file.

e FailArchiveExt—Specify the extension for the file that contains the business
objects that failed processing.
2. Use Connector Configurator Express to configure the ArchivingEnabled
connector property.

3. Establish write permissions on the archive directory.

Specifying request processing
You can cause the JText connector to write business objects to files whose names
are specified dynamically (in each business object instance) or statically (through
meta-objects). You can also cause the connector to return each filename that it
generates statically; this feature is useful to obtain filenames generated with a
unique sequence number. This section contains the following subsections:

* [“Dynamic file naming” on Eageﬂ
* |“Static file naming” on page 59

G

* [“Returning a file’s name” on page 60|

« ['Differences between local and remote processing” on page 60|
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+ |"Configuring the output file” on page 61

Dynamic file naming
To cause the connector to dynamically generate an output filename for each type of
business object, create a dynamic child meta-object. Use the child meta-object:

* either to specify the name of the output file or to receive the name of the
generated filename

* to specify whether to append to or overwrite the output file

Important: In addition to creating the dynamic child meta-object to enable the
connector to generate or return the output filename, if you are using
InterChange Server Express as the integration broker, you must also
modify your maps or collaboration logic to insert into the dynamic
child meta-object’s InFileName attribute a path and filename for each
business object, and, if required, unique sequence numbers.

For more information, see [“Using a dynamic child meta-object” on page 4.

For information about how the connector processes the meta-object, see
fporocessing” on page 10

For information on configuring the connector to use a dynamically generated
output filename, see [“Configuring the output file” on page 61}

Static file naming

When you use meta-objects to specify the name of output files, you must restart
the connector for any changes to take effect. You can specify whether the connector
appends all business objects of a given type to a single file or creates a separate file
for each business object.

When it uses the delivered default configuration, the connector creates an output
file for each business object it processes. It names the output file for the incoming
business object and adds a sequence number to make the name unique; it gives it
the extension of .out. For example, if it receives the Customer and Item business
objects, the connector writes their data to the Customer_1.out and Item_l.out
output files. For information on obtaining the names of generated output files, see
[‘Returning a file’s name” on page 60} For information on the file that stores the
sequence numbers, see|’OutputLog” on page 30,

To use the meta-object to configure the name of output files, do the following:

1. Configure the following attributes of the MO_JTextConnector_Default
meta-object:

* OutputDir—Specify the absolute path of an existing directory to which the
connector is to write files when it processes requests. For more information,
see[“Configuring the output file” on page 61|

* OutputExt—Use this attribute to specify your own extension if you want to
change the delivered default configuration, which causes the connector to
create files with the out extension.

¢ FileSeqEnabled—Keep set to true to cause the connector to output one
business object per file, each with a unique sequence number. Set to false to
cause the connector to output all business objects of a given type to a single
file, either by overwriting or appending. For information on configuring
overwrite or append behavior, see|[Table 9 on page 61
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* OutputFileName—To the cause the connector to append business objects to a
single output file rather than overwrite the data in the file or generate
unique files for each business object, specify the output file’s full path and
filename.

To cause the connector to overwrite the output file each time it receives the
same type of business object, do not specify a value for OutputFileName.

In each of these cases, set FileSeqEnabled to false.
For information on configuring overwrite or append behavior, see|Table 9 on

2. Establish write permissions on the output directory.

Note: You must create meta-objects for specific business objects if the connector is
to use different data formats or file naming conventions for different
business objects.

Returning a file’s name

To cause the connector to return the names of the files it generates, do the

following:

* Use meta-objects to specify path and filenames and to cause the connector to
generate a unique sequence number for each output file. For more information,
see [“Static file naming” on page 59

* Use a dynamic child meta-object to cause the connector to return the name of
each file it generates. Follow the steps in [“Using a dynamic child meta-object’|
but do not specify a value for its InFileName attribute. When the
connector receives a business object whose dynamic child meta-object specifies
OutFileName=CxIgnore, it creates a filename based on the configuration of its
top-level meta-object, and returns the full path and filename as a value in the
InFileName attribute.

Note: The connector populates the InFileName attribute only with a local path,
even when processing files over an FTP server.

Important: In addition to creating the dynamic child meta-object to enable the
connector to generate or return the output filename, if you are using
InterChange Server Express as the integration broker, you must also
modify your maps or collaboration logic to insert into the dynamic
child meta-object’s InFileName attribute a path and filename for each
business object, and, if required, unique sequence numbers.

Differences between local and remote processing
The connector processes files remotely in much the same way that it processes
them locally. There are, however, a few differences:

* When processing events and generating filenames dynamically, the connector
populates the InFileName attribute of the dynamic child meta-object only with a
local path name and not with a remote path.

* When processing requests, if the connector is not configured for dynamic file
naming and FileSeqEnabled evaluates to false and the output file already
exists:

— If processing locally, the connector overwrites the existing file.
— If processing remotely, the connector throws an exception.

* In addition to configuring the standard archive extension attributes for local
event processing, when using the connector to process files remotely over an
FTP server, you can also configure the FTPArchiveDir and FTPRenameExt
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attributes. These attributes enable you to rename and move the remotely
archived file independently of the success of the processing.

For further information see [“Specifying remote archiving” on page 67]

Configuring the output file
able 9| illustrates the possible configuration options for the output file:
P g P P

Table 9. Specifying output files

Desired output condition

Each business object of a given type
is appended to a file whose absolute
path and filename is derived at
runtime from an attribute in the
business object.

Each business object of a given type
overwrites the output file whose
absolute path and filename is derived
at runtime from an attribute in the
business object.

Each business object of a given type
is written to its own unique file
whose name is derived from the
business object’s name and a
generated unique sequence number.

The connector returns the name of
each file it generates. Each business
object of a given type is written to its
own unique file whose name is
derived from the business object’s
name and a generated unique
sequence number.

All business objects of a given type
are appended to a single file whose
name is user-specified.

Each business object of a given type
is written to its own unique file
whose name is user-specified plus a
unique sequence number.

Attributes/property requiring

configuration

Use a dynamic child meta-object
AppSpecificInfo (at business-object level)

For dynamic child meta-object:

QutFileName
FileWriteMode

Use a dynamic child meta-object
AppSpecificInfo (at business-object level)

For dynamic child meta-object:0utFileName

FileWriteMode
QutputDir

FiTleSeqEnabled
QutputFileName

Use a dynamic child meta-object

AppSpecificInfo (at business-object level)

InFileName (in dynamic child
meta-object)

FileWriteMode (in dynamic child

meta-object)

Use meta-object configuration:
MO_JTextConnector_businessobjectname:

QutputDir

FileSeqEnabled
QutputFileName
FileSeqEnabled

QutputFileName

FileSeqEnabled

Attribute/property value

cw_mo_JTextConfig =
DynChildMOName
user-specified pathname and
filename

a or append

cw_mo_JTextConfig =
DynChildMOName
user-specified pathname and
filename

0 or overwrite

user-specified pathname

true
Native

cw_mo_JTextConfig =
DynChildMOName
CxIgnore

N/A

user-specified pathname
true

Native

false

user-specified pathname and
filename
true
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Table 9. Specifying output files (continued)

Attributes/property requiring
Desired output condition configuration

If the connector is processing more OutputFileName
than one type of business object and
OutputFileName is set to a string

other than Native, each business

must have its own top-level

meta-object. For more information,

see [“Specifying the name of the|

[output file” on page 54

Each business object of a given type  OutputDir
overwrites the output file, whose

name is derived from the business

object’s name.

FileSeqEnabled
QutputFileName
The connector returns the name of Use a dynamic child meta-object
each file it generates. Each business
object of a given type is written to its
own unique file whose name is AppSpecificInfo (at business-object level)
user-specified plus a unique sequence
number. InFileName (in dynamic child meta-object)

FilelriteMode (in dynamic child
meta-object)

Use meta-object configuration:
MO_JTextConnector_BOName.
FileSeqEnabled

QutputFileName

Attribute/property value

user-specified pathname and
filename

user-specified pathname

false
Native

cw_mo_JTextConfig =
DynChildMOName
CxIgnore

N/A

true
user-specified pathname and
filename

Specifying multiple event files or multiple event directories

You can configure the connector to pick up only files with a specified extension.
You can also configure the connector to pick up files from multiple directories.

Important: The use of an asterisk (*) for the EventExt attribute to specify that the
connector poll for all files in a single event directory regardless of their

extension is no longer supported.

To specify a separate event directory for each business object type, perform the

following steps:

1. Create a separate meta-object for each supported business object; for example,
create MO_JTextConnector Customer and MO JTextConnector Item. For more

information, see [“Creating a JText meta-obiject for a specific business object” on|

2. Specify the appropriate directory in each meta-object’s EventDir attribute.

Note: The JText connector processes event files in the order of their time stamps,
from the earliest to the most recent, regardless of their location. In other
words, the JText connector processes files located in separate directories in

the chronological order of their time stamps.
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Polling for specific business objects

Configuration of the JText connector differs depending on whether all your event
files are in a single directory, they all have the same extension, they contain a
single business object or multiple business objects, they contain business objects of
one type or multiple types, and they represent each business object on a single line
or on multiple lines.

This section explains the following:

» |“Using EndBODelimiter parsing method”]

— [“Using non-printable characters for an EndBODelimiter” on page 64|

“Using FixedBOSize parsing method” on page 65|

Using EndBODelimiter parsing method

If no value is specified for the EndBODelimiter meta-object attribute, the connector:
* expects the event file to delimit business object strings with <EndB0:BOName>

* specifies <EndBO:BOName> as the delimiter when it writes business object strings
to output files.

If an event file contains only one business object, you can specify EOF (end of file)
for this attribute.

If you set the value of the EndBODelimiter attribute to a non-empty string, the
string is assumed to be the business object delimiter for every file. If the value is
not set or is cleared, the connector assumes the delimiter is <EndBO:B0Name>.

Important: If DataProcessingMode is set to binary and if there is no value specified
for EndBODelimiter, JText will set the default EndBODelimiter to FFO1 (2
bytes) and EndOfFileDelimiter to FFO2 (2 bytes).

able 10 illustrates delimiter options.

Table 10. Using the EndBODelimiter attribute

Conditions Delimiter Notes

File contains one or more business object <EndBO:BOName>or EOL or « Specify as many

strings with one or more types of business user-specified semicolon-separated EOLs as there
object or File contains multiple business object value are new lines between business
strings of the same type of business object; object strings.

each string runs over several lines.

* Specify a custom delimiter in
conjunction with EOLs. A custom
delimiter must always be the first
element when used with EOL. The
following example is valid:
customEndBO;EOL;EOL. The
following example is not valid:
EOL; customEndBO; EOL.
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Table 10. Using the EndBODelimiter attribute (continued)

Conditions Delimiter
Each file contains only one business object EOL For user-specified value
string

File contains multiple business object strings, ~ EOL
one per line

File contains multiple business object strings of None
the same type of business object; each string

runs over several lines without any separators
between business-object strings

Notes

* Specify as many
semicolon-separated EOLs as there
are new lines between business
object strings.

* Specify a user-specified delimiter
in conjunction with EOLs and EOF if
required by the input strings. A
custom delimiter must always be
the first element when used with
EOL. The following example is
valid: customEndBO;EOL;EQOL. The
following example is not valid:
EOL; customEndBO; EOL

Can use the delivered default
meta-object or a custom meta-object
Note: This option is available only
during service call requests and not
for event notification. Do not use this
delimiter in conjunction with any
other delimiter.

Note: If the source file contains empty lines, the connector ignores them.

Using non-printable characters for an EndBODelimiter: To poll for files in
multiple directories, you must create a meta-object for each supported business
object. The value you specify for each meta-object’s EndBODelimiter attribute
depends on whether your source file contains a single business object or multiple

business objects.
* Files that contain a single business object

You can specify EOF as the EndBODelimiter if the entire data file contains only

one business object string.
* Files that contain multiple business objects

If your input file contains multiple business objects that have only a new line as
the business object delimiter, specify the string EOL in the EndBODelimiter
attribute. In this case, the source file contains strings representing multiple

business objects of the same type.

Important: To poll from a file that contains multiple business object types, you
must use the MO_JTextConnector_Default meta-object, and must
ensure that its EventExt and EventDir attributes correctly point to
the directory where this event file is located. To poll for business
object types that are represented in separate event files or whose
event files are located in different directories, you must create a
separate top-level meta-object for each type. Use the EventExt and
EventDir attributes to point to the appropriate directory.

To use a custom data handler when polling files that contain multiple business

objects of different types, see [“Reading multiple business objects of different|

[types from the same file” on page 74)
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If using a name/value format, you cannot specify the EOL business object
delimiter if the event file splits business object data over multiple lines. For more
information, see the Data Handler Guide.

The following examples illustrate the delimiter to use for different event file
formats:

* File contains four business object strings and uses the non-printable character
EOL as the end of business object delimiter:
Sample_BO0™Create™1~TableGenKey5™~strange™TextConnector_924055528 0
Sample_B0“Create™2“TableGenKey5™strange™TextConnector_924055528 0
Sample_B0™Create™3™~TableGenKey5™~strange™TextConnector_924055528 0
Sample_BO0™~Create™4™~TableGenKey5~strange™TextConnector_ 924055528 0

* File contains four business object strings and uses a user-specified value and the
non-printable character EOL as the end of business object delimiter, that is
CustomEndBO;EOL:
Sample_B0™~Create™1™~TableGenKey5~strange™TextConnector_924055528_0CustomEndBO
Sample_B0™~Create™2™~TableGenKey5~strange™TextConnector_924055528_ 0CustomEndBO
Sample_B0“Create™3™~TableGenKey5™~strange™TextConnector_ 924055528 0CustomEndBO
Sample_B0“Create™4~TableGenKey5™~strange™TextConnector_ 924055528 0CustomEndBO

* File that contains four business object strings and uses the non-printable
character EOL;EOL as the end of business object delimiter:

Sample_BO0“Create™1~TableGenKey5™~strange™TextConnector_924055528 0
Sample_B0“Create™2~TableGenKey5™~strange™TextConnector_924055528 0
Sample_B0“Create™3“~TableGenKey5™strange™TextConnector_ 924055528 0

Sample_BO0™~Create™4™~TableGenKey5~strange™TextConnector_ 924055528 0

* File that contains four business object strings and uses None as the end of
business object delimiter:
Sample_B0™~Create™1™~TableGenKey5~strange™TextConnector_924055528_0Sample_BO
~Create™2™TableGenKey5™~strange™TextConnector 924055528 0Sample_BO0“Create™3
“~TabTeGenKey5™strange™~TextConnector_ 924055528 0Sample_BO“Create™4
“~TableGenKey5™strange™~TextConnector_ 924055528 0

Note: The connector is case-sensitive to the string that you specify, except for the
EOL and EQF delimiters.

For more information on creating your own meta-objects, see [‘Creating a JText]
imeta-obiject for a specific business object” on page 73|

FixedBOSize parsing method

This meta-object property is only valid in the following instances:
1. When performing event processing.

2. When DataProcessingMode is set to Binary.

When present with a valid value, this meta-object property overrides the
EndBODelimiter property, and provides users an alternative to the traditional
delimiter based business object parsing. This property enables the connector to
correlate a fixed number of bytes with a single business object. For example, if a
file consisted of 300 bytes, and the FixedB0Size property was set to 100, the JText
Adapter would convert these three 100 byte length packets through a binary
enabled data handler and send them to the InterChange Server Express.

If both FixedB0Size and EndBODelimiter have a value set, then Jtext will take
FixedB0Size for file parsing and it will ignore EndBODelimiter.

Chapter 4. Using JText connector meta-objects 65



Specifying a remote FTP file system

This section describes how to configure the JText adapter to use a remote FIP file
system for event and request processing.

Important: To enable the connector to use a remote FTP file system, you must

specify an FTP URL in the attribute (for event processing) or
ﬁ

tputDir|attribute (for request processing). You must also resolve all
firewall issues before using the connector to perform FTP operations.

This section describes the following:

+ [“Remote event processing”]|

* ["Remote request processing” on page 70|

“Notes on configuring the connector for FTP transfer” on page 71|

Remote event processing

To configure the connector to use a remote FTP file system for event processing,
you must specify the FITP URL, FTP login information, a local directory into which
the connector downloads the event files from the remote directory, archiving
information, and information related to how the connector behaves when the FTP
server is unavailable. This section describes all of these configurations as well as
additional optional configurations.

+ |“Specifying the FTP URL and login information”]

+ |“Specifying the local directory” on page 67|

+ |“Specifying remote archiving” on page 67

* [“Specifying remote polling” on page 68

+ [“How the connector processes events from a remote site” on page 68

* |“Identifying files on a mainframe: Optional configuration” on page 69

* |[“Summary of configuration operations for event processing” on page 69|

Specifying the FTP URL and login information: The connector polls for events
from the directory specified in the meta-object attribute. To configure the
connector to use a remote FTP file system for event processing, specify the FTP
URL as the value of this attribute. The FTP URL must conform to IETF standards.

In addition to specifying the FTP server in the URL, you can optionally specify the
following information in the EventDir meta-object attribute:

* Name of a user with privileges to connect to the FIP server and perform FTP

operations—If you do not specify the username in EventDir, specify it in the
FTPUserld meta-object attribute.

* Password of a user with privileges to connect to the FTP server and perform

FTP operations—If you do not specify the password in EventDir, specify it in the
FTPPassword meta-object attribute.

* Port number—If the port is not specified in EventDir, the connector uses the
default port.

* Remote event directory—If you do not specify the remote event directory in
EventDir, the connector polls the event files from the directory to which the
connection is established to the FTP server.

Important: You can specify the FTP values either in a static top-level meta-object

or in a dynamic child meta-object. If the username and password are
not specified in any meta-object attribute, the connector terminates
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when attempting to connect to the FTP server. For more information,
see|"Using a dynamic child meta-object” on page 4/

The examples below illustrate three different formats for EventDir attribute values:

URL only with required values:
ftp://ftp.companyA.com

URL with optional username and port number values:
ftp://companyA:admin@ftp.companyA.com: 1433

URL with optional username, port number, and remote event directory values:
ftp://companyA:admin@ftp.companyA.com:1433/temp/JTextConn/Default/Event

URL for Linux / MVS related FTP setup
ftp://ftpuser:ftppwd@ftpserver.in.ibm.com:21/home/ftpuser/JText/event

Specifying the local directory: In addition to specifying the FTP URL and related
login information, you must specify the location of the local directory into which
the connector downloads the event files from the remote directory. To specify the
local directory, use the [FTPLocalEventDir| meta-object attribute.

Important: If the connector finds a proper FTP URL in EventDir, but does not find
the FTPLocalEventDir meta-object attribute or finds an invalid or a
blank value for this attribute, the connector does not start. The
connector does not evaluate the FTPLocalEventDir attribute when
configured to run locally.

Specifying remote archiving: You have several options in specifying how the
connector handles remote archiving. To specify a remote archive directory, use the
meta-object attribute. This attribute specifies the relative path of the
archive directory on the FTP server. The directory must already exist. There are
several options for using this attribute to specify archiving:

* Specifying a value for the FTPArchiveDir attribute but no value for the
attribute causes the connector to append a timestamp to the event
filename and move it to the remote FIP server archive directory specified in the
FTPArchiveDir attribute.

* Specifying a value both for the FTPArchiveDir attribute and the FTPRenameExt
attribute causes the connector to rename the processed event filename, adding a
timestamp and ignoring the FTPRenameExt, then move it to the FTP server
archive directory specified in the FTPArchiveDir attribute.

* Specifying no value either for the FTPArchiveDir or the FTPRenameExt attributes
causes the connector to delete the processed event file without archiving it.

* Specifying no value for the FTPArchiveDir attribute but specifying a value for
the FTPRenameExt attribute causes the connector to rename the processed event
filename with the value specified in FTPRenameExt, and move it to the directory
specified in the attribute.

File naming with timestamping for remote FTP servers: Support for host file
systems (MVS) using Sequential datasets has been enhanced by providing for time
stamping to avoid duplicate file names. MVS doesn’t support special characters,
such as "_", in a dataset or recordset name. On Windows, Linux, or i5/0S
platforms, we use a time stamp in the original filename while archiving the file
This avoids duplicate filenames in an archive folder, thereby preventing the
overwriting of an existing file.
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We use the following format for MVS systems to overcome this limitation:
Event File: Test.in
Archived file: Test.TSyyyyMM.TSDDHHMM.TSSsSss

Where: yyyy -- year
MM -- month
DD -- date
HH -- hour
MM -- minutes
Ss -- seconds

Sss -- milliseconds
On MVS platforms the dataset or recordset separator is ".” (dot) and maximum
number of ".” (dots) allowed in a dataset or recordset is 6 (six) The dataset or
recordset name must not exceed 8 characters per ".” (dot) and the total number of
characters must not exceed 44 characters. Here is an example of a file name in this
format:
FTPRenameExt -- ARCHIVE
Archived File -- (SAMPLE) .ARCHIVE.TS200304.7S290535.7542234

Note: The members of PDS cannot be renamed with time stamps while archiving.
Hence, an alternate mechanism is provided for PDS archival. Each member
of a PDS that falls into the FTPEventFileMask is archived under the parent
PDS, with filename specified as the FTPRenameExt. The archival file will be
rewritten each time with the latest processed file.

Specifying remote polling: You can use the|"FTPPol1Frequency" on page 30|
configuration property to set how frequently the connector polls an FTP server
measured in the number of standard poll cycles. This setting is useful if the
connector is still reading files from the local event directory when it starts the next
polling cycle.

For example, if ["Pol1Frequency” on page 106|is set to 10000, and
FTPPoTl1Frequency is set to 6, the connector polls the local event directory every 10
seconds and polls the remote directory every 60 seconds. The connector performs
FTP polling only if you specify a value for this property. If FTPPo11Frequency
evaluates to 0 or blank, the connector does not perform FTP polling.

For more information, see ["Tuning the performance of the JText connector” on|

How the connector processes events from a remote site: When polling for events
from a remote site, the connector performs the following steps:

1. Obtains the server name, port number, username, password, and remote event
directory from meta-object attributes or default values.

2. Establishes a connection to the remote FTP site to get event files from the
remote event directory.

3. Downloads the event files from the remote directory to the local directory
specified in the FTPLocalEventDir meta-object attribute.

Note: To enable the connector to process events using FTP, this attribute must
have a value.

4. Polls the local directory.

ﬂlustrates local and remote event processing.
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Return to main process
to poll from local directory (3)

JText connector
main process

Call FTP wrapper

A for file transfer
Poll from event @ While polling
directory Y
@ Check for FTP URL @
Not found in EventDir attribute| Found

Figure 6. Local and remote event notification operation

Identifying files on a mainframe: Optional configuration: Use the
[FTPEventFileMask attribute to identify file extensions on a mainframe that do not
adhere to the same naming standards that apply to Windows, Linux, or i5/0S
systems. If no value is provided for this attribute, the connector uses the value
specified in the attribute.

When specifying a value for FTPEventFileMask, you can include wildcard
characters. The following example illustrates several possible formats for this
attribute:

ACT.Z1UC.*

ACT.=.INPT

*.Z1UC.INPT

If the connector finds more than one file at the remote site that meets the criteria
specified for FTPEventFileMask, it does the following:

1. Downloads all specified remote event files to the directory specified in the
FTPLocalEventDir attribute.

2. Renames the extension of the remote files with the value specified in the
FTPRenameExt| meta-object attribute. Renaming the files prevents the connector
from polling the same file in the next poll cycle.

3. Disconnects from the FTP server.

4. Processes the files locally in the directory specified in the FTPEventFileMask
meta-object attribute.

Summary of configuration operations for event processing: To configure the
connector to use a remote FTP file system for event processing, specify the
following configuration values:

* Specify the FTP URL in the meta-object attribute. Optionally, specify
the name and password of a user with privileges to connect to the FTP server
and perform FTP operations.

* If you do not specify the login name and password in the EventDir meta-object
attribute, do so in the [FTPUserId and [FTPPassword meta-object attributes.

* If you do not specify the port in the EventDir meta-object attribute, the
connector uses the default FTP port.

» Use the [FTPLocalEventDir| meta-object attribute to specify the local system
directory into which the connector downloads event files from the FTP site.

* On a mainframe that does not adhere to the same naming standards that apply
to Windows, Linux, or i5/0S systems, use the [FTPEventFileMask| meta-object
attribute to identify files to be polled.
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* To configure the connector to work with an MVS FTP server when the remote

system is MVS, specify MVS in the |[FTPOSPTatform|attribute.

Remote request processing

To configure the connector to use a remote FTP file system for request processing,

you must specify the FTP URL, FTP login information, and a remote directory into
which the connector uploads the request files from the local directory. This section
describes all of these configurations as well as additional optional configurations.

* |“Specifying the FTP URL and Login Information”|

» [“How the connector processes service call requests to a remote site” on page 7(}

* [“Summary of configuration operations for request processing” on page 71|

Specifying the FTP URL and Login Information: The connector uploads service
call request files into the directory specified in the meta—object attribute.
To configure the connector to use a remote FTP file system for request processing,
specify the FIP URL as the value of this attribute. The FTP URL must conform to
IETF standards.

In addition to the FTP URL, you can optionally specify the following information
in the OutputDir meta-object attribute:

* Name of a user with privileges to connect to the FIP server and perform FIP

operations—If you do not specify the username in OutputDir, specify it in the
FTPUserld meta-object attribute.

* Password of a user with privileges to connect to the FIP server and perform
FTP operations—If you do not specify the password in OutputDir, specify it in
the [FTPPassword meta-object attribute.

* Port number—If the port is not specified in EventDir, the connector uses the
default port.

* Remote output directory—If you do not specify the remote output directory in
OutputDir, the connector loads the request files into the default connection

directory (the directory on the FTP server to which the connection is
established).

Important: You can specify the FTP values either in a static top-level meta-object
or in a dynamic child meta-object. If the username and password are
not specified in any meta-object attribute, the connector terminates by
throwing an exception. For more information, see [Using a dynamid
[child meta-object” on page 4)

The examples below illustrate three different formats for OutputDir attribute
values:

URL only with required values:
ftp://ftp.companyA.com

URL with optional username and port number values:
ftp://companyA:admin@ftp.companyA.com: 1433

URL with optional username, port number, and remote output directory values:
ftp://companyA:admin@ftp.companyA.com:1433/temp/JTextConn/Default/Out

How the connector processes service call requests to a remote site: When the
connector is configured for FTP processing and it receives a service call request, it
performs the following steps:
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1. Obtains the server name, port number, username, and password from
meta-object attributes or default values.

2. Establishes a connection to the remote FTP site to place service call request files
from the local directory.

3. Uploads the request files from the local directory to the remote directory.

4. Disconnects from the remote server.

ﬂlustrates local and remote request processing.

Return to main process @

Service call @ JText connector n [
request ——» main process
qu P Call FTP wrapper
A for file transfer
@ While processing A
Process a request a request
to output directory

@ Check for FTP URL @ |
Not found in OutputDir attribute Found

Figure 7. Local and remote request operations

Summary of configuration operations for request processing: To configure the
connector to use a remote FIP file system for request processing, specify the
following configuration values:

¢ Specify the FTP URL in the |QutputDir meta-object attribute. Optionally, specify
the name and password of a user with privileges to connect to the FTP server
and perform FTP operations.

* If you do not specify the login name and password in the OutputDir meta-object
attribute, do so in the [FTPUserId|and [FTPPassword meta-object attributes.

* If you do not specify the port in the OutputDir meta-object attribute, the
connector uses the default port.

* To configure the connector to work with an MVS FTP server when the remote

system is MVS, specify MVS in the |[FTPOSPTatform|attribute.

Notes on configuring the connector for FTP transfer
The following features apply to FTP transfer of data:

* The connector uses Binary mode of data transfer when doing FTP operations.

e The connector does not use FTP transfer of data if the value of the EventDir or
OutputDir meta-object attribute does not begin with ftp://.

* During event processing, if the event business object contains a dynamic child
meta-object with an InFileName attribute, the connector populates this attribute
with the full path of the file specified in the FTPLocalEventDir, but not the path
on the remote system.

* Values entered in the EventExt and FTPRenameExt meta-object attributes cannot
be same; if they were the same, the connector would continuously pick up files
that it had already picked up earlier.

* The connector does not support file sizes that are not supported by FTP.

* You must consider case sensitivity for file names, extensions, and other
components in accordance with the platform of the FTP site.

* Transferring files from a remote FTP site might impact the connector’s
performance.
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* When data is exchanged to or from the remote FTP site, there is a chance that
data can be corrupted or lost due to loss of network connection or similar
problems.

* The integration broker does not maintain any type of connection cache or pool.
Connections are opened and closed for each polling cycle and request
processing. Network latency and other configuration outside the control of the
connector can impact its performance.

* The value specified for the FTPLocalEventDir meta-object attribute can not be
specified as the value of the EventDir meta-object attribute of any meta-object
that does not specify FIP values. This restriction prevents the connector from
using values specified in different types of business objects in same directory
that require totally different types of processing.

* If the remote event directory or output directory specified at the end of the FTP
URL does not exist, the connector shuts down when it interacts with the FTP
site. It does not shut down at the time of connector startup.

* When configuring the connector for processing files over an FIP server, you
must configure the FTP server to use the Linux settings required by the Apache
Commons Net APIL

Configuring secure FTP

JText adapter uses the SSL (Secure Socket Layer) protocol to establish a secure
communication channel between the adapter and the FIP server. For this feature,
the FTP server needs to be a secure FIP server supporting this protocol. JText
adapter makes use of the IBM JSSE package that is an implementation of the SSL
protocol. The adapter works in passive FTP mode and implicit SSL mode. This
section describes the additional configurations required to use the secure FTP
feature of JText adapter.

To configure secure FTP:

1. Install and configure a secure FTP server supporting SSL protocol. JText adapter
uses a SSL protocol to transfer data between client application and FIP server.
Therefore, a secure FTP server needs to be installed which supports SSL
protocol and configured appropriately for SSL communication. The server
should have a private key and a certificate.

2. If applicable, configure the Firewall settings. JText adapter uses a passive FTP
mode of data transfer with secure FTP server. Therefore, if there is a firewall
between the client and the server, the firewall settings may need to be
configured to enable this mode.

3. Set the client trust store. During SSL communication, the server sends its
certificate to the client for verification. The client verifies the certificate to
ascertain that it is communicating with the intended server. To enable this
verification process, the server’s certificate should be present in the client’s trust
store. The server’s certificate can be imported into the client’s trust store using
the keytool utility, for example:

keytool -import -v -alias serverCert -file server.cert
-keystore clientTrustStore

where server.cert is the certificate of the server and clientTrustStore is the trust
store of the client.

4. Set the trustStore system property in the adapter startup script. The adapter
startup script should include the following system property,

-Djavax.net.ssl.trustStore=C:\MyKeyStore\clientTrustStore
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where clientTrustStore is the trust store of the client as specified in Step 3.

5. Make sure that you use ftps in the FIP URL. For secure communications, the
FTP URL should have ftps as the protocol, for example:
ftps://host:port/ftpdir

Specifying a data handler

To specify a data handler to be used by the JText Connector, perform the following

steps:

1. Determine the format used by the application with which the JText connector
communicates. Note that only one data handler class can be registered for any
given format type.

2. Configure the following child objects of the top-level JText meta-object:

* EventDataHandler—To specify the data handler meta-object to be used for
event processing (business object string or byte array to business object
conversion).

* OutputDataHandler—To specify the data handler meta-object to be used for
the request processing (business object to business object string or byte array
conversion).

Changing the specified data handler
To change the data handler from the delivered default (either to a different
delivered one or to a custom data handler), do the following:

¢ Verify that the connector supports the business object specified as the default
value in the EventDataHandler and OutputDataHandler attributes.

* Verify that the class or jar file that contains the data handler is included in the
class path when the connector is started. If you use a delivered data handler, or
you add a custom data handler to the CustDataHandler.jar file (as
recommended in the Data Handler Guide), the file is included in the delivered
startup script (start_JText.bat or connector_manager_JText.sh).

* Make sure you specify an appropriate EndBODelimiter value for the data handler
that you are using.

For information on creating a data handler, see the Data Handler Guide.

Creating a JText meta-object for a specific business object

When you create a JText meta-object for a specific business object, rename the
meta-object to identify the particular business object. For example, to create
meta-objects for the Customer and Item business objects, you might name the
meta-objects M0_JTextConnector_Customer and MO_JTextConnector_Item.

Tip: Use default meta-objects when all business objects to be written to files have
exactly the same configuration. In other words, all text files reside in the same
event directory and are written to the same output directory, use the same
data handler, and have the same file extension (or should be put into the
same file). Create your own meta-objects if the connector must use different
processing for different business objects on requests, or if specific processing
instructions are required for polling. If you create separate meta-objects for
specific business objects, the connector uses your meta-objects for both
integration-broker requests and subscription delivery operations.

Any business object for which you do not create a meta-object is configured by the
values in the default MO_JTextConnector_Default meta-object. For the business

object definition for this default meta-object, see the \repository\JText directory.
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Reading multiple business objects of different types from the
same file

If a text file contains multiple business objects of different types, you must use the
MO_JTextConnector_Default meta-object, and must ensure that its EventExt and
EventDir attributes correctly point to the directory where this event file is located.
Each business object in the file must be separated by the same delimiter.

The delivered data handlers can determine the name of each business object from
the input string. In other words, when using the default top-level JText meta-object
and the delivered data handlers, you need not use the <EndBO:BOName> delimiter
to identity each type of business object in a file that contains multiple types.

If you develop a custom data handler to convert business object strings to business
objects, ensure that it can interpret the business object’s type from the input string.

Specifying values for ObjectEventID attributes

You do not have to add ObjectEventId attributes to business object strings. For
event notification business objects, the connector framework populates these
business object attributes if the IDs are not populated by the connector.

For service call request business objects, ObjectEventId attributes are either ignored
or included in the string written to a file. Whether ObjectEventId attributes are
included in the output file depends on the data handler that is used.

Setting up a second instance of a JText connector
To set up a second instance of the JText connector, follow these steps:

1. Make a copy of the JText connector directory and its repository directory and
rename them. For example, assume you name the second connector definition
JText2. After you create the second directories, your directory structure looks
like the following;:

\connectors\JText
\connectors\JText2
\repository\JText
\repository \JText2

2. Copy all the meta-objects for the JText connector (there should be at least two
of them) and modify the name of the business objects. For example, for the
JText2 connector, change the names from MO_JText2ConnectorBOName to
MO_JText2ConnectorBOName.

There are two ways you can copy the meta-objects:

* Create a text file that contains the M0_JText2Connector_BOName meta-object
and its children. Use a text editor’s search and replace option to replace
MO_JTextConnector_ with MO_JText2Connector_BOName.

* Use Business Object Designer Express to copy the meta-objects one at a time.

Important: Before you can manipulate a business object definition in
Business Object Designer Express, you must copy the text from
the top of the \repository\ReposVersion.txt file to the top of
every definition file.

3. In Connector Configurator Express, copy the connector’s definition and rename
it to JText2Connector. Change the supported meta-objects and business objects.

4. Copy any new definition files into the repository. To use Business Object
Designer Express to copy business object definitions into the repository, select
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the Save To Server submenu from the File menu. Alternatively, on InterChange
Server Express, perform the following steps to copy business object definitions
into the repository from the operating system:

a. Copy the text from the top of the \repository\ReposVersion.txt file to the
top of every definition file.

b. Use the following repos_copy command to copy in the new meta-objects
and business objects:

repos_copy -sServerName -iFileName

5. Refresh the integration broker’s administration utility to verify the new
business objects.

6. For Linux, make a copy of the existing connector manager script for the JText
connector and change the parameters to refer to JText2. For Windows, make a
copy of the existing shortcut for the JText connector and change the parameters
to refer to JText2, and modify it to point to the JText2 directory rather than the
JText directory.

7. For i5/0S systems, add the new connector instance to the Console.
8. Restart the integration broker.

9. In Linux, run the connector manager script. In Windows, click on the new
shortcut. In i5/0S, use the Console to start the connector.

Tuning the performance of the JText connector

To tune the polling performance of the JText connector, set the following connector
configuration properties as described below.

* PollQuantity — This property sets the maximum number of business objects that
the connector can deliver to the integration broker in a single call to poll for
events. If you set Pol1Quantity to a high value, the connector tries to submit
more business objects in one poll. This can improve performance and helps to
clear up internal queues and memory usage.

Enabling the connector to post large quantities of business objects to the
integration broker, however, can affect other business-integration components.
For example, if the message queuing system has been set up with default values,
the queues can fill up quickly if the JText connector sends many large business
objects through the system. Therefore, when tuning performance, keep in mind
that there is an optimal performance setting for Pol1Quantity.

* PollFrequency — This connector configuration property specifies the amount of
time between polling actions. Setting this property to a longer time slows down
the connector during event processing. Setting it to a shorter time ensures that
events are picked up, converted to business objects, and delivered quickly.

In other words, the connector picks up new files during each poll call. If the
connector does not poll often, it takes longer for it to deliver the files that accrue
in the event directory. If the connector polls frequently, it picks up the files more
often and delivers them more frequently.

The more frequently the connector polls for events, however, the less time it has
for processing requests. If you use the connector primarily for request
processing, set|Pol1Frequency|to a lower value than if you use the connector
primarily for event processing.

As with the Pol1Quantity configuration property discussed above, setting

Pol1Frequency| to an extreme value, such as a very long or short time, can affect
the performance of other business-integration components.

* FTPPol1Frequency — This connector configuration property specifies how
frequently the connector polls an FIP server measured in the number of

standard poll cycles. For example, if [Pol1Frequency|is set to 10000, and
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FTPPol1Frequency is set to 6, the connector polls the local event directory every
10 seconds and polls the remote directory every 60 seconds. The connector
performs FTP polling only if you specify a value for this property. If
FTPPoT1Frequency evaluates to 0 or blank, the connector does not perform FTP

polling.
In summary, the best approach to improving performance in polling is to set
PollQuantity, |Pol1Frequency], and FTPPol1Frequency so that they complement each
other.

Generating sample files for testing

You might want to generate a file that looks like the input file that the JText
connector expects. This file can assist you in setting up the output formats in the
source application. A sample file can also be used for testing.

On InterChange Server Express, the easiest way to generate a file similar to the
input file is as follows:

1. Create a pass-through collaboration that takes as input and sends to the
destination the business object that is to be written out to a file.

2. Bind the source port to a connector that supports that business object and can
be emulated by Test Connector.

3. Bind the destination port to the JText connector.

4. Input sample values for the business object into Test Connector, and send that
business object to the JText connector. The JText connector writes the values to
the output file in the configured format.

This process enables you to see multiple business objects written to a single file,
which you can use as input during testing.

Generating sample business objects for testing

You might want to generate business objects that look like ones the JText connector
expects. You can populate the business objects with values to use during testing.

To cause the connector to automatically generate business object templates, use the
GenerateTemplate configuration property. You can generate a definition for each
business object that the connector supports.

The connector uses the value of the GenerateTemplate property to create an
instance of a serialized business object when the connector starts up. A serialized
business object is the string representation of the business object that the data
handler creates. Use Connector Configurator Express to specify the names of the
business objects for this property.

The syntax for this property is BOName;BOName, where the name of a specific
business object name is substituted for BOName. Case is significant. To specify
more than one business object, separate the names with a semicolon, as in
Customer;Item. Ending punctuation is not required. Templates for these business
objects are created the next time you start the connector.

The generated templates contain the delivered default values that are set for the
attributes of the business objects in the business object’s definition. If there is no
delivered default value for an attribute, it is either ignored (using CxIgnore) or left
blank (using CxBlank). One child business object is created for each
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single-cardinality child business object and two identical instances of a child
business object are created for multiple-cardinality business objects.

To begin generating templates for a specified business object, start the connector.

The connector writes the template to the same file as the output file. If you do not
want to use this feature, leave the GenerateTemplate property empty.
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Chapter 5. Troubleshooting the JText connector

This chapter includes the following information to help you diagnose problems
with the JText connector.

* [“Error message logging”]|

* |“Problem with meta-object naming”]|

* [“Problem with event triggering”

» [“JText failure handling” on page 80|

* [“Event log file” on page 80

* |‘Failure recovery” on page 81|

* |“Recovery from business object delimiter errors” on page 82|

« |[“Recovery from subscription errors” on page 83

+ |[“Recovery from formatting errors” on page 83|

+ [“Recovery from sending errors” on page 83|

[“Data handlers and supported business objects” on page 84

Error message logging

Error messages are logged to the standard connector log file, STDOUT, or to the file
specified by the LogFileName standard connector property.

Errors are also logged to the event log file. For more information on the event log
file, see[“Event log file” on page 80|

Problem with meta-object naming

During connector startup, the following error message means that the meta-object
name does not correspond to the connector instance name.

Wrong subscription: JText_Customer doesn't have supporting MO:
this BO is unsubscribed."

If the meta-object name does not match the name of the connector instance, the
meta-object does not recognize the business objects supported by the connector. To
prevent this, name the meta-object to correspond with the connector instance. For
example, a meta-object named MO_JTextConnector2_Default recognizes business
objects supported by the JText2 connector.

Problem with event triggering

The connector ignores event files with the following delimiter problems:

e The EndBODelimiter attribute in the top-level meta-object is set to a valid value,
such as the plus sign (+) or the pipe symbol (), but the event file does not
contain the specified delimiter at the end of each business object.

¢ The connector is configured to look for the EndB0:BOName business object
delimiter, but the event file does not contain this delimiter. The connector logs a
warning message that states:

Unable to create Workunits from file filename. Check EndBODelimiter in the file.
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In both of the above cases, the file remains in the event directory without any
change.

The connector also keeps the file in the event directory without change when
device failures occur while a file is being accessed, opened, or closed. For example,
if the system tries to access a file when it is out of memory, the connector ignores
the file.

JText failure handling

For the JText connector, the following types of errors can occur:

Table 11. JText error types

Type of error Description

Business object delimiter Business object delimiter failures occur when the EndBODelimiter

failures attribute in the top-level meta-object is set to a valid value, and
the event file contains the specified delimiter at the end of each
business object, but the data itself uses the delimiter value in its
text. When the connector encounters the delimiter value in the
text, it sends a partial business object string to the formatter,
which fails processing. In this case, the connector writes the event
to the filename_timestamp.fail file, which contains records for all
business objects that encountered delimiter failures.

Subscription errors Can occur if the connector can find the business object delimiter
and retrieve the business object name, but the business object is
not subscribed. In this case, an event is sent to the
filename_timestamp.unsub file, which contains records for all
unsubscribed business objects.

Formatting errors Can occur if the connector finds the delimiter with a business
object name that does not match the input business object name,
or the format in the business object file does not match the format
of the meta-object. An event is sent to the
filename_timestamp.fail file, which contains records for all
business objects that failed formatting.

Sending errors Can occur if the connector tries to send a business object when the
integration broker is down. If the Send operation fails, an event is
sent to the filename_timestamp.fail file, which contains records
for all business objects that were not successfully sent.

Event log file

The connector logs information about successfully processed business objects to the
event.log file. If the connector goes down before it processes all business objects in
an event file, it uses this log file during recovery to ensure that it sends each
business object only once to the integration broker.

The format of the log file is:

EventFileName::1,2,n

where EventFileName is the name of the current event file, and each number
represents the sequence number of a successfully processed business object in that

file.

For example, assume that the connector has successfully processed three of the first
four business objects in the Customer.in file, and that the second business object
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failed processing. Assume also that the connector has not yet finished processing
Customer.in. In this case, the event.log file might look like the following:
Linux:

$ProductDir/JText/Event/Customer.in:: 1,3,4

Windows:
C:\JText\Event\Customer.in:: 1,3,4

i5/0S:
/QIBM /UserData/WebBIICS/JText/Event/Customer.in:: 1,3,4

If the connector went down before processing the entire Customer.in file, at startup
the connector uses the information in the log file to resume processing the event
file at the point where it had stopped processing. The connector reads the log to
get the name of the event file to be recovered and the latest business-object
sequence number. Then the connector begins sending to the integration broker all
business objects in the event file whose sequence number is greater than the last
number in the log file. For example, given the file above, the connector begins
processing the fifth business object in the Customer.in file.

The connector keeps the contents of the log file in memory to enhance
performance. It accesses the file on disk only to update it with a new entry. The
connector reads the log file only at recovery time.

For information on how the connector uses the event.log file in the recover
y
process, see |“Failure recovery.’]

Failure recovery

Note: The following recovery steps do not apply if a disk failure occurs or a disk
is full.

To recover from failures during event notification, the connector does the
following:

1. The connector processes business object strings from the event file. When it
successfully processes an entry, the connector logs the entry in the event.log
file. It also writes it to a file in the archive directory (specified in the
ArchiveDir meta-object attribute).

* If none of the business objects in the event file have failed processing, the
connector archives the successfully processed ones in an archive file with the
extension specified in the SuccessArchiveExt attribute.

 If any of the business objects in the event file have failed processing, the
connector archives the successfully processed ones in an archive file with the
extension specified in the PartialArchiveExt attribute.

* After it has written business objects to the file specified in the
SuccessArchiveExt attribute, if any business object fails processing, the
connector changes the extension of this file to the one specified in
PartialArchiveExt.

The delivered default values for these extensions are .success and .partial.
2. If errors occur, the connector does the following;:

* Subscription errors— the connector creates the archive file in the archive
directory with the extension specified in the UnsubscribedArchiveExt
meta-object attribute. The delivered default value for this extension is .unsub.
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¢ Formatting errors or sending errors—the connector creates the archive file in
the archive directory with the extension specified in the FailArchiveExt
meta-object attribute. The delivered default value for this extension is .fail.

* Business object delimiter errors—the connector creates the archive file in the
archive directory with the extension specified in the FailArchiveExt
attribute. It also backs up the event file by moving it to the archive directory
and changing its extension to the one specified in OriginalArchiveExt.

The connector does not log the failed business objects to event.log.

3. After the connector processes all business objects in an event file, it clears the
event.log file and begins writing entries to it from the next event file.

4. If the connector goes down before it processes all business objects in an event
file, it uses the information in event.log to determine where to begin
processing during the recovery process. When it comes back up, the connector
checks whether there are any entries in the log file.

* If there are no entries, the connector sends all business objects in the event
file to the integration broker.

* If there are entries, the connector uses this information to resume processing
an event file at the point where it had stopped processing. The connector
reads the log to get the name of the event file to be recovered and the latest
business-object sequence number. Then the connector sends to the integration
broker all business objects in the event file whose sequence number is greater
than the last number in the log file. For example, if the event file contains 15
business objects and the last sequence number in the log file is 8, the
connector sends the last seven business objects to the integration broker.

Using the log file prevents the connector from sending the same event
multiple times to the integration broker. The connector keeps the log file in
memory to enhance performance. The connector accesses the file on disk
only to update it with a new entry, and reads the log file only at recovery
time.

If you set the |"EventRecovery” on page 30| configuration property to retry, the
connector at startup automatically recovers outstanding events from a
previously processed file. However, if you set this property to abort, the
connector terminates during startup if there are any events to be recovered.

5. To recover from errors that occurred during the event notification process, you
must restart the connector. Before doing this, however, do the following:

* Examine the files that the connector created for failed and unsubscribed
business objects. Make appropriate corrections so that the business object
strings can be successfully processed when the connector starts.

* Copy appropriate files from the archive directory to the event directory and
change all .fail or .unsub extensions to the extension specified in the
EventExt attribute (by default, .1in). To facilitate record-keeping, rename these
files in a meaningful way. For example, rename Customer.unsub to
Customer_unsub_resubmit.in.

* You may need to perform additional steps manually to recover, depending
on the type of failure that has occurred.

The following guidelines can help you determine what recovery steps to take,
based on the type of error that occurred.

Recovery from business object delimiter errors

The connector writes the business object to an archive file in the archive directory,
giving it the extension specified in the FailArchiveExt meta-object attribute. To
handle recovery for such a failure, do the following:
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1. Ensure that the event file contains the business object delimiter, that the
delimiter is correct, and that it does not contain the delimiter value in the data
itself as text. If the use of the delimiter is not correct, correct it.

2. Review the connector’s log file (specified in the LogFileName configuration
attribute) to determine other reasons why the process failed.

3. Copy the file from the archive directory to the event directory and change the
.fail extension to the extension specified in the EventExt attribute (by default,
.in). To facilitate record-keeping, rename the file in a meaningful way. For
example, rename Customer.fail to Customer_delimiter_error.in.

Recovery from subscription errors

The connector writes the business object to a file located in the archive directory,
giving it the extension specified in the UnsubscribedArchiveExt meta-object
attribute. To handle recovery for such a failure, do the following:

1. Open the archived file, find that business object string, and verify that the
business object name and verb are subscribed. Make appropriate corrections if
necessary.

2. Ensure that the integration broker is running.

3. Copy the file from the archive directory to the event directory and change the
.unsub extension to the extension specified in the EventExt attribute (by default,
.in). To facilitate record-keeping, rename the file in a meaningful way. For
example, rename Customer.unsub to Customer_unsub_resubmit.in.

Recovery from formatting errors

The connector writes the business object to a file located in the archive directory,
giving it the extension specified in the FailArchiveExt meta-object attribute. To
handle recovery for such a failure, do the following;:

1. Open the archived file and verify that:

* The business object string format matches the expected format in the
meta-object. If there is a mismatch, either change the format type in the
meta-object or in the business object string.

¢ The formatting syntax of the business object string is correct. If it is incorrect,
correct it.

2. Copy the file from the archive directory to the event directory and change the
.fail extension to the extension specified in the EventExt attribute (by default,
.in). To facilitate record-keeping, rename the file in a meaningful way. For
example, rename Customer.fail to Customer_fail_formatting.in.

Recovery from sending errors

The connector writes the business object to a file located in the archive directory,

giving it the extension specified in the FailArchiveExt meta-object attribute. To

handle recovery for such a failure, do the following:

1. Verify that all components of the business-integration system are running.

2. Copy the file from the archive directory to the event directory and change the
.fail extension to the extension specified in the EventExt attribute (by default,
.in). To facilitate record-keeping, rename the file in a meaningful way. For
example, rename Customer.fail to Customer_fail_sending.in.

3. Restart the connector.
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Data handlers and supported business objects

If the connector returns an error stating that the data handler has not been
configured, verify that the meta-object for the data handler is included in the list of
supported business objects. The most common error returned by the connector
states that the BOPrefix is not set.

The list of supported business objects for the DHFormatter should include the
following:

* MO_]JTextConnector_Default

* MO_JTextConnector_BusObjName (meta-objects created for specific business
objects)

* Business objects that are to be read from or written to a file.

* The meta-object for the data handler (which is specified in the
DataHandlerConfigMO attribute of the MO_JTextConnector_Default meta-object).
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Chapter 6. Migrating to or upgrading the JText connector

This chapter describes how to upgrade to the 5.6.x version of the JText connector
from the 5.3.0 version, and to the 4.0.x version of the JText connector from the 3.2.0
version. It also describes how to upgrade to the JText connector from the Text
connector.

Note: The JText connector versions 4.4.x and 4.3.x contain no specific configuration
changes. They contain only optional configuration changes, none of which is
necessary unless you want to take advantage of the new options. See the
[“New in this release” on page vii|section for details.

Topics included in this chapter include:

+ [“Upgrade scenarios”]

+ [“Upgrading to version 5.6.x from version 5.3.x”|

* [“Reasons to upgrade to version 4.0.x from version 3.2.0” on page 86

+ [“Upgrading to version 4.0.x” on page 86|

* [“Reasons to upgrade from the Text connector” on page 88|

+ [“Upgrading to the JText connector” on page 8§

Upgrade scenarios

If you are upgrading to the 4.1.x release of the JText connector from the 4.0.x
release, follow the instructions in [“Upgrade scenarios” on page 85|

If you are upgrading to the 4.1.x release of the JText connector from the 3.2.0
release, follow the instructions in [“Upgrading to version 4.0.x” on page 86|and
[“Upgrade scenarios” on page 85

If you are upgrading to the JText connector from the Text connector, follow the
instructions in |[“Upgrading to the JText connector” on page 88|

Upgrading to version 5.6.x from version 5.3.x

This section explains:

* |["Meta-object changes” on page 85

* |”Architecture changes” on page 86|

Meta-object changes

The MO_JTextConnector_Default meta-object contains six new attributes
(FTPTransferType, FixedB0Size, DataProcessingMode, FTPDataStructure,
MVSSiteCommand, and LargeObject) that have enhanced the functionality of JText.

You must add these attributes to the JText top-level meta-object, and configure
values for them. Use Business Object Designer Express to add the new attributes,

provide your own default values for them, and save the changes to the definition.

Add the six new attributes to each of the meta-objects that you have customized
from MO_JTextConnector_Default. For example, if you have created your own
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meta-object for the Customer and Item business objects, add the new attributes to
these meta-objects, provide your own default values for them, and save the
changes to the repository.

For more information, see [Table 8 on page 46

Architecture changes

This section explains:

« |[“Configuration property changes”|

Configuration property changes

For the 5.6.0 release, two new Connector-specific configuration properties have
been added:

* SortFilesOnTimestamp - New connector specific property has been added to the
adapter and allows the adapter to pick up event files based on the modification
timestamp.

* NoPol1 - A new Connector-specific boolean property has been introduced, to
optionally turn off polling. The default value is false. When set to true, the
adapter only processes requests and does not poll.

Reasons to upgrade to version 4.0.x from version 3.2.0

With version 4.0.x of the JText connector, the structure of the meta-objects required
to configure the connector was dramatically simplified, thus simplifying the
configuration process.

Whereas earlier versions of the connector used a meta-object structure that
included three levels of hierarchy and at least ten different meta-objects, the 4.0.x
version uses only two meta-objects and only two levels of hierarchy. This new
version changes the way that you configure the connector but does not change the
connector’s functionality.

Upgrading to version 4.0.x

Because the new meta-objects use the same configuration data as previous
versions, upgrading does not require changing any configuration values. However,
because the new meta-objects store the data in differently named attributes in far
fewer meta-objects, upgrading does require the following operations:

¢ Create new meta-objects.

* Replace the value of each attribute’s DefaultValue property in each new
meta-object with the customized default values in your existing meta-objects.

* Remove all obsolete meta-objects from the repository.

IBM WBIS Support provides a utility that automates the above operations. To
execute these operations manually, perform the following steps:

1. Make a backup of the repository by using the repos_copy utility. For example,
the following command backs up the entire contents in the Serverl repository
to the output file, InterChangeRepository.out:
repos_copy -oInterChangeRepository.out -sServerl -pmypassword

2. For each of your existing top-level meta-objects, create a new meta-object with
the same attributes as the new delivered top-level meta-object,
MO_JTextConnector_Default . For example, if you have created your own
meta-object for the Customer business object named according to the previous
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naming convention (M0_JTextConnector_Customer), create a new meta-object for
Customer that uses the new naming convention (M0_JTextConnector_Customer).

3. Set the default values of the new meta-objects based on the values in the
original meta-objects. See [Table 12| for the correspondence between the
attributes in the original meta-objects and the new ones.

4. Use System Manager to delete the original set of meta-object definitions from
the repository, keeping only the ones just created and
MO_JTextConnector_Default DHFormatter.

illustrates the correspondence between the original and new attributes,
including the names of the original meta-objects. Whereas multiple meta-objects
contained the original attributes, MO_JTextConnector_Default meta-object contains
all of the new attributes.

Table 12. Correspondence of original meta-objects and attributes to new attributes

Original meta-object name Original attribute name New attribute name
MO_JTextConnector_BOName_Connector DummyKey N/A
MO_]JTextConnector_BOName_ArchiveDir Directory ArchiveDir
MO_]JTextConnector_BOName_ArchiveFileExt Success SuccessArchiveExt
Partial ArchiveExt
Fail Fail ArchiveExt
Unsubscribed ArchiveExt
MO_JTextConnector_BOName_EventDir Directory EventDir
FileExt EventExt
MO_JTextConnector_BOName_OutputDir Directory OutputDir
FileExt OutputExt
FileSequencingEnabled FileSeqEnabled
MO_JTextConnector_BOName_FormatType N/A
MO_JTextConnector_BOName_ServicePolicy OutputFileName OutputFileName
EndBODelimiter EndBODelimiter
MO_JTextConnector_BOName_FormatService EventService EventFormat
OutputService OutputFormat

does not include the following information

Attribute(s) corresponding to the MO_JTextConnector_BOname_FormatType
meta-object

Previous versions of the connector required you to list all possible formats in the
MO_JTextConnector_BOname_FormatType meta-object before configuring the
formats to use for event and output files. In the new meta-object structure, you
need only configure the formats to be used for event and output files. This
change is indicated inby the absence of corresponding attribute(s) for
the MO_JTextConnector_BOname_FormatType meta-object.

Meta-objects for the individual Formatters

The top-level meta-object has two attributes that contain a Formatter meta-object.
The Formatter meta-objects have the same attributes as in the original structure,
and are used in the same way. Because three of the four Formatters have been
deprecated, the only relevant Formatter meta-object is

MO _JTextConnector_BOname _DHFormatter.
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Reasons to upgrade from the Text connector

If your site currently uses the Text connector to communicate between an
application and integration broker, consider upgrading to the JText connector for
the following reasons:

* Performance. The Text connector processes only one file at a time, which can
hinder performance when processing large files or a great number of files.

* Format availability. The Text connector handles few format types.
* Ease of modification. The Text connector is more difficult to modify.

In contrast, the JText connector can be configured to:
* Process multiple files at one time.

¢ Search multiple locations for specific business objects, thereby increasing
performance.

* Accommodate a wider range of format types.

Upgrading to the JText connector

To upgrade to the JText connector from the Text connector:

1. From the product CD, copy the JText directory to the %CROSSWORLD%connectors
directory.

2. Open a Command Prompt window and use repos_copy to add the following
two files to the repository: CN_JText.txt and MO_JTextConnector_Default.txt.

3. Ensure that the specified directories for the following meta-object attributes
have been created: ArchiveDir, EventDir, and OutputDir. If these directories
have not been created, create them.

4. Configure the meta-object attributes.
5. Subscribe to the desired business objects.
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Appendix. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration Server Express adapters. The
information covers InterChange Server Express.

For information about properties specific to this connector, see the relevant section
in this guide.

New properties

These standard properties have been added in this release:
* AdapterHelpName

* BiDi.Application

* BiDi.Broker

* BiDi.Metadata

¢ BiDi.Transformation

* ControllerEventSequencing

* jms.ListenerConcurrency

* jms.TransportOptimized

* TivoliTransactionMonitorPerformance

Standard connector properties overview

Connectors have two types of configuration properties:
 Standard configuration properties, which are used by the framework

* Application, or connector-specific, configuration properties, which are used by
the agent

These properties determine the adapter framework and the agent run-time
behavior.

This section describes how to start Connector Configurator Express and describes
characteristics common to all properties. For information on configuration
properties specific to a connector, see its adapter user guide.

Starting Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the sections on Connector Configurator Express in
this guide.

Connector Configurator Express and System Manager run only on the Windows
system. If you are running the connector on a Linux system, you must have a
Windows machine with these tools installed.

To set connector properties for a connector that runs on Linux, you must start up

System Manager on the Windows machine, connect to the Linux integration broker,
and bring up Connector Configurator Express for the connector.
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Configuration property values overview
The connector uses the following order to determine a property’s value:
1. Default
2. Repository for InterChange Server Express integration broker.
3. Local configuration file
4. Command line

The default length of a property field is 255 characters. There is no limit on the
length of a STRING property type. The length of an INTEGER type is determined
by the server on which the adapter is running.

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s update
method determines how the change takes effect.

The update characteristics of a property, that is, how and when a change to the
connector properties takes effect, depend on the nature of the property.

There are four update methods for standard connector properties:

* Dynamic
The new value takes effect immediately after the change is saved in System
Manager. However, if the connector is in stand-alone mode (independently of
System Manager).

* Agent restart (InterChange Server Express only)
The new value takes effect only after you stop and restart the connector agent.

* Component restart
The new value takes effect only after the connector is stopped and then restarted
in System Manager. You do not need to stop and restart the agent or the server
process.

* System restart
The new value takes effect only after you stop and restart the connector agent
and the server.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator Express window, or see the Update Method
column in[Table 13 on page 91}

There are three locations in which a standard property can reside. Some properties
can reside in more than one location.

* ReposController
The property resides in the connector controller and is effective only there. If
you change the value on the agent side, it does not affect the controller.

* ReposAgent
The property resides in the agent and is effective only there. A local
configuration can override this value, depending on the property.

* LocalConfig
The property resides in the configuration file for the connector and can act only
through the configuration file. The controller cannot change the value of the
property, and is not aware of changes made to the configuration file unless the
system is redeployed to update the controller explicitly.
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Standard properties quick-reference

provides a quick-reference to the standard connector configuration
properties. Not all connectors require all of these properties, and property settings

may differ. .

See the section following the table for a description of each property.

Note: In the Notes column in [Table 13} the phrase “RepositoryDirectory is set to
<REMOTE>" indicates that the broker is InterChange Server Express.

Table 13. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
AdapterHelpName One of the valid Template name, if valid, | Component Supported regional
subdirectories in or blank field restart settings.
<ProductDir>\bin\Data\ Include chs_chn,
App\Help that has a valid cht_twn, deu_deu,
<Regional Setting> esn_esp, fra_fra,
directory ita_ita, jpn_jpn,
kor_kor, ptb_bra,
and enu_usa (default).
AdminInQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMININQUEUE restart only when the value
of DeliveryTransport
is JMS
AdminOutQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/ADMINOUTQUEUE restart only when the value
of DeliveryTransport
is JMS
AgentConnections 1 through 4 1 Component This property is valid
restart only when the value
of DeliveryTransport
is MQ or IDL, the value
of Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
AgentTraceLevel 0 through 5 0 Dynamic
for ICS;
otherwise
Component
restart
ApplicationName Application name The value specified for | Component
the connector restart
application name
BiDi.Application Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value

attributes:

Ist letter: I,V
2nd letter: L,R
3rd letter: Y, N
4th letter: S, N
5th letter: H, C, N

of BiDi.Transforma tion
is true
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Table 13. Summary of standard configuration properties (continued)

wardMode

Update
Property name Possible values Default value method Notes
BiDi.Broker Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value of
attributes: BiDi.Transformation
is true. If the value of
1st letter: I,V BrokerType is
2nd letter: L,R .ICS/ the property
3rd letter: Y, N is read-only.
4th letter: S, N
5th letter: H, C, N
BiDi.Metadata Any valid combination ILYNN (five letters) Component This property is valid
of these bidirectional restart only if the value of
attributes: BiDi.Transformation
is true.
Ist letter: I,V
2nd letter: L,R
3rd letter: Y, N
4th letter: S, N
5th letter: H, C, N
BiDi.Transformation true or false false Component This property is valid
restart only if the value of
BrokerType is
not WAS
BrokerType ICS ICS Component
restart
CharacterEncoding Any supported code. ascii7 Component This property is valid
The list shows this subset: restart only for C++ connectors.
ascii7, ascii8, SJIS,
Cp949, GBK, Big5,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
CommonEventInfrastruc true or false false Component
ture restart
CommonEventInfrastruc A URL string, for No default value. Component This property is valid
tureURL example, restart only if the value of
corbaloc:iiop: CommonEvent
host:2809. Infrastructure is true.
ConcurrentEventTrig 1 through 32,767 1 Component This property is valid
geredFlows restart only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ContainerManagedEvents | Blank or JMS Blank Component This property is valid
restart only when the value
of Delivery Transport
is JMS.
ControllerEventSequenc true or false true Dynamic This property is valid
ing only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
ControllerStore AndFor true or false true Dynamic This property is valid

only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
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Table 13. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
ControllerTraceLevel 0 through 5 0 Dynamic This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is ICS.
DeliveryQueue Any valid JMS <CONNECTORNAME> Component This property is valid
queue name /DELIVERYQUEUE restart only when the value
of Delivery Transport
is JMS.
DeliveryTransport IDL or JMS IDL when the value of Component If the value of
RepositoryDirectory is restart RepositoryDirectory is
<REMOTE>, otherwise not <REMOTE>,
JMS the only valid value for
this property is JMS.
DuplicateEventElimina true or false false Component This property is valid
tion restart only if the value of
DeliveryTransport is JMS.
EnableOidForFlowMoni true or false false Component This property is valid
toring restart only if the value of
BrokerType is ICS.
FaultQueue Any valid queue name. <CONNECTORNAME> Component This property is
/FAULTQUEUE restart valid only if the value
of DeliveryTransport
is JMS.
jms.FactoryClassName CxCommon.Messaging. jms CxCommon.Messaging. Component This property is
. IBMMQSeriesFactory, jms.IBMMQSeriesFactory |restart valid only if the value
CxCommon.Messaging of DeliveryTransport
.Jms.SonicMQFactory, is JMS.
or any Java class name
jms.ListenerConcurrency 1 through 32767 1 Component This property is
restart valid only if the value of
jms.TransportOptimized
is true.
jms.MessageBrokerName If the value of crossworlds.queue. Component This property is valid
jms.FactoryClassName manager restart only if the value of
is IBM, use DeliveryTransport
crossworlds.queue. is JMS
manager.
jms.NumConcurrent Positive integer 10 Component This property is valid
Requests restart only if the value of
DeliveryTransport
is JMS
jms.Password Any valid password Component This property is valid
restart only if the value of
DeliveryTransport
is JMS
jms.TransportOptimized true or false false Component This property is valid
restart only if the value of
DeliveryTransport
is JMS and the value of
BrokerType is ICS.
jms.UserName Any valid name Component This property is valid
restart only if the value of

Delivery Transport is JMS.
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Table 13. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update
method

Notes

JvmMaxHeapSize

Heap size in megabytes

128m

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

JvmMaxNativeStackSize

Size of stack in kilobytes

128k

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

JvmMinHeapSize

Heap size in megabytes

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

ListenerConcurrency

1 through 100

Component
restart

This property is valid
only if the value of
DeliveryTransport is MQ.

Locale

This is a subset of the
supported locales:
en_US, ja_JP, ko KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,

es_ES, pt_BR

en_US

Component
restart

LogAtInterchangeEnd

true or false

false

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

MaxEventCapacity

1 through 2147483647

2147483647

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

MessageFileName

Valid file name

InterchangeSystem. txt

Component
restart

MonitorQueue

Any valid queue name

<CONNECTORNAME>
/MONITORQUEUE

Component
restart

This property is valid
only if the value of
DuplicateEventElimination
is true and
ContainerManagedEvents
has no value.

OADAutoRestartAgent

true or false

false

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.

OADMaxNumRetry

A positive integer

1000

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
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Table 13. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
OADRetryTimelnterval A positive integer 10 Dynamic This property is valid
in minutes only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is ICS.
PollEndTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
PollFrequency A positive integer 10000 Dynamic
(in milliseconds) if broker is
ICS;
otherwise
Component
restart
PollQuantity 1 through 500 1 Agent restart | This property is valid
only if the value of
ContainerManagedEvents
is JMS.
PollStartTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
RepositoryDirectory <REMOTE> if the broker |For ICS, the value is set | Agent restart
is ICS; otherwise any to <REMOTE>
valid local directory.
RequestQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/REQUESTQUEUE restart only if the value of
DeliveryTransport
is JMS
ResponseQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/RESPONSEQUEUE restart only if the value of
DeliveryTransport is JMS.
RestartRetryCount 0 through 99 3 Dynamic
if ICS;
otherwise
Component
restart
RestartRetryInterval A value in minutes 1 Dynamic
from 1 through if ICS;
2147483647 otherwise
Component
restart
RHF2MessageDomain mrm or xml mrm Component This property is valid
restart only if the value
of DeliveryTransport
is JMS and the value of
WireFormat is CwXML.
SourceQueue Any valid WebSphere <CONNECTORNAME> Agent restart | This property is valid
MQ queue name /SOURCEQUEUE only if the value of
ContainerManagedEvents
is JMS.
SynchronousRequest Any valid queue name. <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSREQUEST restart only if the value
QUEUE of DeliveryTransport
is JMS.
SynchronousRequest 0 to any number 0 Component This property is valid
Timeout (milliseconds) restart only if the value

of DeliveryTransport
is JMS.
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Table 13. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
SynchronousResponse Any valid queue name <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSRESPONSE restart only if the value
QUEUE of DeliveryTransport
is JMS.
TivoliMonitorTransaction true or false false Component
Performance restart
WireFormat CwXML or CwBO CwXML Agent restart | The value of this
property must be CwXML
if the value
of RepositoryDirectory
is not set to <REMOTE>.
The value must
be CwBO if the value of
RepositoryDirectory is set
to <REMOTE>.
WsifSynchronousRequest | 0 to any number 0 Component This property is not valid
Timeout (milliseconds) restart if the value of
BrokerType is ICS..
XMLNameSpaceFormat short or long short Agent restart | This property is not valid
if the value of
BrokerType is
ICS.

Standard properties
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This section describes the standard connector configuration properties.

AdapterHelpName

The AdapterHelpName property is the name of a directory in which
connector-specific extended help files are located. The directory must be located in
<ProductDir>\bin\Data\ App\Help and must contain at least the language
directory enu_usa. It may contain other directories according to locale.

The default value is the template name if it is valid, or it is blank.

AdmininQueue

The AdminInQueue property specifies the queue that is used by the integration
broker to send administrative messages to the connector.

The default value is <CONNECTORNAME>/ADMININQUEUE

AdminOutQueue

The AdminOutQueue property specifies the queue that is used by the connector to
send administrative messages to the integration broker.

The default value is <CONNECTORNAME>/ADMINOUTQUEUE

AgentConnections

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened when the ORB initializes.

The default value of this property is 1.
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AgentTraceLevel

The AgentTraceLevel property sets the level of trace messages for the
application-specific component. The connector delivers all trace messages
applicable at the tracing level set and lower.

The default value is 0.

ApplicationName

The ApplicationName property uniquely identifies the name of the connector
application. This name is used by the system administrator to monitor the
integration environment. This property must have a value before you can run the
connector.

The default is the name of the connector.

BiDi.Application
The BiDi.Application property specifies the bidirectional format for data coming
from an external application into the adapter in the form of any business object
supported by this adapter. The property defines the bidirectional attributes of the
application data. These attributes are:

* Type of text: implicit or visual (I or V)

* Text direction: left-to-right or right-to-left (L or R)

* Symmetric swapping: on or off (Y or N)

 Shaping (Arabic): on or off (S or N)

* Numerical shaping (Arabic): Hindi, contextual, or nominal (H, C, or N)

This property is valid only if the BiDi.Transformation property value is set to true.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).

BiDi.Broker

The BiDi.Broker property specifies the bidirectional format for data sent from the
adapter to the integration broker in the form of any supported business object. It
defines the bidirectional attributes of the data, which are as listed under
BiDi.Application above.

This property is valid only if the BiDi.Transformation property value is set to true.
If the BrokerType property is ICS, the property value is read-only.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).

BiDi.Metadata

The BiDi.Metadata property defines the bidirectional format or attributes for the
metadata, which is used by the connector to establish and maintain a link to the
external application. The attribute settings are specific to each adapter using the
bidirectional capabilities. If your adapter supports bidirectional processing, refer to
section on adapter-specific properties for more information.

This property is valid only if the BiDi.Transformation property value is set to true.

The default value is ILYNN (implicit, left-to-right, on, off, nominal).
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BiDi.Transformation

The BiDi.Transformation property defines whether the system performs a
bidirectional transformation at run time.

If the property value is set to true, the BiDi.Application, BiDi.Broker, and
BiDi.Metadata properties are available. If the property value is set to false, they
are hidden.

The default value is false.

BrokerType

The BrokerType property identifies the integration broker type that you are using.
The value is ICS,, or .

CharacterEncoding

The CharacterEncoding property specifies the character code set used to map from
a character (such as a letter of the alphabet, a numeric representation, or a
punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. C++ connectors use the
value ascii7 for this property.

By default, only a subset of supported character encodings is displayed. To add
other supported values to the list, you must manually modify the

\Data\Std \stdConnProps.xml file in the product directory (<ProductDir>). For
more information, see the Connector Configurator Express appendix in this guide.

ConcurrentEventTriggeredFlows

The ConcurrentEventTriggeredFlows property determines how many business
objects can be concurrently processed by the connector for event delivery. You set
the value of this attribute to the number of business objects that are mapped and
delivered concurrently. For example, if you set the value of this property to 5, five
business objects are processed concurrently.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), the following properties must configured:

* The collaboration must be configured to use multiple threads by setting its
Maximum number of concurrent events property high enough to use multiple
threads.

* The destination application’s application-specific component must be configured
to process requests concurrently.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and is performed serially.
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This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1.

ContainerManagedEvents

The ContainerManagedEvents property allows a JMS-enabled connector with a
JMS event store to provide guaranteed event delivery, in which an event is
removed from the source queue and placed on the destination queue as one JMS
transaction.

When this property is set to JMS, the following properties must also be set to
enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType and DHClass (data
handler class) properties. You can also add DataHandlerConfigMOName (the
meta-object name, which is optional). To set those values, use the Data Handler
tab in Connector Configurator Express.

Although these properties are adapter-specific, here are some example values:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab are displayed only if you have
set the ContainerManagedEvents property to the value JMS.

Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pollForEvents() method, thereby disabling that method’s functionality.

The ContainerManagedEvents property is valid only if the value of the
DeliveryTransport property is set to JMS.

There is no default value.

ControllerEventSequencing

The ControllerEventSequencing property enables event sequencing in the connector
controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE> (BrokerType is ICS).

The default value is true.

ControllerStoreAndForwardMode

The ControllerStoreAndForwardMode property sets the behavior of the connector
controller after it detects that the destination application-specific component is
unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches InterChange Server Express (ICS), the connector
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controller blocks the request to the application-specific component. When the
application-specific component becomes operational, the controller forwards the
request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE> (the value of the BrokerType property is ICS).

The default value is true.

ControllerTraceLevel

The ControllerTraceLevel property sets the level of trace messages for the
connector controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE>.

The default value is 0.

DeliveryQueue

The DeliveryQueue property defines the queue that is used by the connector to
send business objects to the integration broker.

This property is valid only if the value of the DeliveryTransport property is set to
JMS.

The default value is <CONNECTORNAME>/DELIVERYQUEUE.

DeliveryTransport

The DeliveryTransport property specifies the transport mechanism for the delivery
of events. For Java Messaging Service, the value is JMS.

* If the value of the RepositoryDirectory property is set to <REMOTE>, the value
of the DeliveryTransport property can be IDL or JMS, and the default is IDL.

* If the value of the RepositoryDirectory property is a local directory, the value
can be only JMS.

The connector sends service-call requests and administrative messages over
CORBA IIOP if the value of the RepositoryDirectory property is IDL.

The default value is JMS.
JMS

The JMS transport mechanism enables communication between the connector and
client connector framework using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as
jms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName
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are listed in Connector Configurator Express. The properties
Jjms .MessageBrokerName and jms.FactoryClassName are required for this transport.

There may be a memory limitation if you use the JMS transport mechanism for a
connector in the following environment when InterChange Server Espress (ICS) is
the integration broker.

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768MB of
process heap size, set the following variable and property:

* Set the LDR_CNTRL environment variable in the CWSharedEnv.sh script.

This script is located in the \bin directory below the product directory
(<ProductDir>). Using a text editor, add the following line as the first line in the
CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows larger than this limit, page swapping can
occur, which can adversely affect the performance of your system.

* Set the value of the IPCCBaseAddress property to 11 or 12. For more
information on this property, see the WebSphere Business Integration Server Express
Installation Guide for Windows, for Linux, or for i5/OS.

DuplicateEventElimination

When the value of this property is true, a J]MS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, during
connector development, the connector must have a unique event identifier set as
the business object ObjectEventld attribute in the application-specific code.

Note: When the value of this property is true, the MonitorQueue property must
be enabled to provide guaranteed event delivery.

The default value is false.

EnableOidForFlowMonitoring

When the value of this property is true, the adapter runtime will mark the
incoming ObjectEventID as a foreign key for flow monitoring.

This property is only valid if the BrokerType property is set to ICS.

The default value is false.

FaultQueue

If the connector experiences an error while processing a message, it moves the
message (and a status indicator and description of the problem) to the queue
specified in the FaultQueue property.

The default value is <CONNECTORNAME>/FAULTQUEUE.

jms.FactoryClassName

The jms.FactoryClassName property specifies the class name to instantiate for a
JMS provider. This property must be set if the value of the DeliveryTransport
property is JMS.
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The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

The jms.ListenerConcurrency property specifies the number of concurrent listeners
for the JMS controller. It specifies the number of threads that fetch and process
messages concurrently within a controller.

This property is valid only if the value of the jms.Optimized Transport property is
true.

The default value is 1.

jms.MessageBrokerName

The jms.MessageBrokerName specifies the broker name to use for the J]MS
provider. You must set this connector property if you specify JMS as the delivery
transport mechanism (in the DeliveryTransport property).

When you connect to a remote message broker, this property requires the following
values:

QueueMgrName : Channel :Hos tName : PortNumber

where:

QueueMgriName is the name of the queue manager.

Channel is the channel used by the client.

HostName is the name of the machine where the queue manager is to reside.
PortNumberis the port number used by the queue manager for listening

For example:
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

The default value is crossworlds.queue.manager. Use the default when connecting
to a local message broker.

jms.NumConcurrentRequests

The jms.NumConcurrentRequests property specifies the maximum number of
concurrent service call requests that can be sent to a connector at the same time.
Once that maximum is reached, new service calls are blocked and must wait for
another request to complete before proceeding.

The default value is 10.

jms.Password

The jms.Password property specifies the password for the JMS provider. A value
for this property is optional.

There is no default value.

jms.TransportOptimized

The jms.TransportOptimized property determines if the WIP (work in progress) is
optimized. You must have a WebSphere MQ provider to optimize the WIP. For
optimized WIP to operate, the messaging provider must be able to:

1. Read a message without taking it off the queue

2. Delete a message with a specific ID without transferring the entire message to
the receiver’s memory space
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3. Read a message by using a specific ID (needed for recovery purposes)
4. Track the point at which events that have not been read appear.

The JMS APIs cannot be used for optimized WIP because they do not meet
conditions 2 and 4 above, but the MQ Java APIs meet all four conditions, and
hence are required for optimized WIP.

This property is valid only if the value of DeliveryTransport is JMS and the value of
BrokerType is ICS.

The default value is false.

jms.UserName

the jms.UserName property specifies the user name for the JMS provider. A value
for this property is optional.

There is no default value.

JvmMaxHeapSize

The JvmMaxHeapSize property specifies the maximum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The JvmMaxNativeStackSize property specifies the maximum native stack size for
the agent (in kilobytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The JvmMinHeapSize property specifies the minimum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1m.

ListenerConcurrency

The ListenerConcurrency property supports multithreading in WebSphere MQ
Listener when ICS is the integration broker. It enables batch writing of multiple
events to the database, thereby improving system performance.

This property valid only with connectors that use MQ transport. The value of the
DeliveryTransport property must be MQ.
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The default value is 1.

Locale

The Locale property specifies the language code, country or territory, and,
optionally, the associated character code set. The value of this property determines
cultural conventions such as collation and sort order of data, date and time
formats, and the symbols used in monetary specifications.

A locale name has the following format:
Ul _TT.codeset

where:

Il is a two-character language code (in lowercase letters)

TT is a two-letter country or territory code (in uppercase letters)

codeset is the name of the associated character code set (may be optional).

By default, only a subset of supported locales are listed. To add other supported
values to the list, you modify the \Data\Std\stdConnProps.xml file in the
<ProductDir>\bin directory. For more information, refer to the Connector
Configurator Express appendix in this guide.

If the connector has not been internationalized, the only valid value for this
property is en_US. To determine whether a specific connector has been globalized,
refer to the user guide for that adapter.

The default value is en_US.

LogAtinterchangeEnd

The LogAtInterchangeEnd property specifies whether to log errors to the log
destination of the integration broker.

Logging to the log destination also turns on e-mail notification, which generates
e-mail messages for the recipient specified as the value of MESSAGE_RECIPIENT
in the InterchangeSystem.cfg file when errors or fatal errors occur. For example,
when a connector loses its connection to the application, if the value of
LogAtInterChangeEnd is true, an e-mail message is sent to the specified message
recipient.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

MaxEventCapacity

The MaxEventCapacity property specifies maximum number of events in the
controller buffer. This property is used by the flow control feature.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The value can be a positive integer between 1 and 2147483647.

The default value is 2147483647.
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MessageFileName

The MessageFileName property specifies the name of the connector message file.
The standard location for the message file is \connectors\messages in the product
directory. Specify the message file name in an absolute path if the message file is
not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a connector has its own message file, see the
individual adapter user guide.

The default value is InterchangeSystem.txt.

MonitorQueue

The MonitorQueue property specifies the logical queue that the connector uses to
monitor duplicate events.

It is valid only if the value of the DeliveryTransport property is JMS and the value
of the DuplicateEventElimination is true.

The default value is <CONNECTORNAME>/MONITORQUEUE

OADAutoRestartAgent

the OADAutoRestartAgent property specifies whether the connector uses the
automatic and remote restart feature. This feature uses the WebSphere
MQ-triggered Object Activation Daemon (OAD) to restart the connector after an
abnormal shutdown, or to start a remote connector from System Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the WebSphere MQ-triggered OAD
feature. see the WebSphere Business Integration Server Express Installation Guide for
Windows, for Linux or for i5/OS.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is false.

OADMaxNumRetry

The OADMaxNumRetry property specifies the maximum number of times that the
WebSphere MQ-triggered Object Activation Daemon (OAD) automatically attempts
to restart the connector after an abnormal shutdown. The OADAutoRestartAgent
property must be set to true for this property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 1000.
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OADRetryTimelnterval

The OADRetryTimelnterval property specifies the number of minutes in the
retry-time interval for the WebSphere MQ-triggered Object Activation Daemon
(OAD). If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this
property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is ICS).

The default value is 10.

PollEndTime

The PollEndTime property specifies the time to stop polling the event queue. The
format is HH:MM, where HH is 0 through 23 hours, and MM represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

PollFrequency

The PollFrequency property specifies the amount of time (in milliseconds) between
the end of one polling action and the start of the next polling action. This is not
the interval between polling actions. Rather, the logic is as follows:

* Poll to obtain the number of objects specified by the value of the PollQuantity
property.

* Process these objects. For some connectors, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by the PollFrequency property.
* Repeat the cycle.

The following values are valid for this property:
* The number of milliseconds between polling actions (a positive integer).

* The word no, which causes the connector not to poll. Enter the word in
lowercase.

* The word key, which causes the connector to poll only when you type the letter
p in the connector Command Prompt window. Enter the word in lowercase.

The default is 10000.
Important: Some connectors have restrictions on the use of this property. Where

they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.
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PollQuantity

The PollQuantity property designates the number of items from the application
that the connector polls for. If the adapter has a connector-specific property for
setting the poll quantity, the value set in the connector-specific property overrides
the standard property value.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the ContainerManagedEvents property has a value.

An e-mail message is also considered an event. The connector actions are as
follows when it is polled for e-mail.

¢ When it is polled once, the connector detects the body of the message, which it
reads as an attachment. Since no data handler was specified for this mime type,
it will then ignore the message.

* The connector processes the first BO attachment. The data handler is available
for this MIME type, so it sends the business object to Visual Test Connector.

* When it is polled for the second time, the connector processes the second BO
attachment. The data handler is available for this MIME type, so it sends the
business object to Visual Test Connector.

* Once it is accepted, the third BO attachment should be transmitted.

PollStartTime

The PollStartTime property specifies the time to start polling the event queue. The
format is HH:MM, where HH is O through 23 hours, and MM represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

RepositoryDirectory

The RepositoryDirectory property is the location of the repository from which the
connector reads the XML schema documents that store the metadata for business
object definitions.

If the integration broker is ICS, this value must be set to set to <REMOTE>
because the connector obtains this information from the InterChange Server
Express repository.

When the integration broker is a WebSphere message broker or WAS, this value is

set to <ProductDir>\repository by default. However, it may be set to any valid
directory name.

RequestQueue

The RequestQueue property specifies the queue that is used by the integration
broker to send business objects to the connector.

This property is valid only if the value of the DeliveryTransport property is JMS.
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The default value is <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

The ResponseQueue property specifies the JMS response queue, which delivers a
response message from the connector framework to the integration broker. When
the integration broker is InterChange Server Express (ICS), the server sends the
request and waits for a response message in the JMS response queue.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

The RestartRetryCount property specifies the number of times the connector
attempts to restart itself. When this property is used for a connector that is
connected in parallel, it specifies the number of times the master connector
application-specific component attempts to restart the client connector
application-specific component.

The default value is 3.

RestartRetryinterval

The RestartRetryInterval property specifies the interval in minutes at which the
connector attempts to restart itself. When this property is used for a connector that
is linked in parallel, it specifies the interval at which the master connector
application-specific component attempts to restart the client connector
application-specific component.

Possible values for the property range from 1 through 2147483647.

The default value is 1.

RHF2MessageDomain

The RHF2MessageDomain property allows you to configure the value of the field
domain name in the J]MS header. When data is sent to a WebSphere message
broker over JMS transport, the adapter framework writes JMS header information,
with a domain name and a fixed value of mrm. A configurable domain name lets
you track how the WebSphere message broker processes the message data.

This is an example header:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>

Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

This property is not valid if the value of BrokerType is ICS. Also, it is valid only if
the value of the DeliveryTransport property is JMS, and the value of the
WireFormat property is CwXML.

Possible values are mrm and xml. The default value is mrm.
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SourceQueue

The SourceQueue property designates the JMS source queue for the connector
framework in support of guaranteed event delivery for J]MS-enabled connectors
that use a JMS event store. For further information, see|‘ContainerManagedEvents”]
in page 99,

This property is valid only if the value of DeliveryTransport is JMS, and a value for
ContainerManagedEvents is specified.

The default value is <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequestQueue

The SynchronousRequestQueue property delivers request messages that require a
synchronous response from the connector framework to the broker. This queue is
necessary only if the connector uses synchronous execution. With synchronous
execution, the connector framework sends a message to the synchronous request
queue and waits for a response from the broker on the synchronous response
queue. The response message sent to the connector has a correlation ID that
matches the ID of the original message.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE

SynchronousRequestTimeout

The SynchronousRequestTimeout property specifies the time in milliseconds that
the connector waits for a response to a synchronous request. If the response is not
received within the specified time, the connector moves the original synchronous
request message (and error message) to the fault queue.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is 0.

SynchronousResponseQueue

The SynchronousResponseQueue property delivers response messages in reply to a
synchronous request from the broker to the connector framework. This queue is
necessary only if the connector uses synchronous execution.

This property is valid only if the value of DeliveryTransport is JMS.

The default is <CONNECTORNAME>/SYNCHRONOUSRESPONSEQUEUE

TivoliMonitorTransactionPerformance

The TivoliMonitorTransactionPerformance property specifies whether IBM Tivoli
Monitoring for Transaction Performance (ITMTP) is invoked at run time.

The default value is false.

WireFormat
The WireFormat property specifies the message format on the transport:

* If the value of the RepositoryDirectory property is a local directory, the value is
CwXML.
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* If the value of the RepositoryDirectory property is a remote directory, the value
is CwBO.
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. IBM may have patents or
pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents.
You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you. This
information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated
in new editions of the publication. IBM may make improvements and/or changes
in the product(s) and/or the program(s) described in this publication at any time
without notice. Any references in this information to non-IBM Web sites are
provided for convenience only and do not in any manner serve as an endorsement
of those Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk. IBM may use or
distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you. Licensees of this program who wish to
have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been
exchanged, should contact:
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IBM Corporation

577 Airport Blvd., Suite 800
Burlingame, CA 94010
Us.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us. Any performance data
contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available
systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment. Information concerning non-IBM
products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products. All statements
regarding IBM’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only. This information contains
examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is
entirely coincidental. COPYRIGHT LICENSE: This information contains sample
application programs in source language, which illustrate programming techniques
on various operating platforms. You may copy, modify, and distribute these sample
programs in any form without payment to IBM, for the purposes of developing,
using, marketing or distributing application programs conforming to the
application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. If you are viewing this information softcopy, the
photographs and color illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program. General-use programming interfaces
allow you to write application software that obtain the services of this program’s
tools. However, this information may also contain diagnosis, modification, and
tuning information. Diagnosis, modification and tuning information is provided to
help you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.
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Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:
i5/0S

IBM

the IBM logo

AIX

CICS

CrossWorlds

DB2

DB2 Universal Database

Domino

IMS

Informix

iSeries

Lotus

Lotus Notes

MQIntegrator

MQSeries

MVS

0S/400

Passport Advantage

SupportPac

WebSphere

z/0S

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both. MMX,
Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both. Java and all Java-based
trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both. Linux is a trademark of Linus Torvalds in the United States,
other countries, or both. Other company, product or service names may be
trademarks or service marks of others.

e
JAVA.

WebSphere Business Integration Server Express, Version 4.4, and WebSphere
Business Integration Server Express Plus, Version 4.4
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